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Patents and Trademarks

Amnis Corporation's technologies are protected under one or more of the following U.S.
Patent Numbers: 6211955; 6249341; 6473176; 6507391; 6532061; 6563583; 6580504;
6583865; 6608680; 6608682; 6618140; 6671044; 6707551; 6,763,149; 6778263;
6875973; 6906792; 6934408; 6947128; 6947136; 6975400; 7006710; 7009651; 7057732;
7079708; 7087877; 7190832; 7221457; 7286719; 7315357; 7450229; 752275; 7567695;
7610942; 7634125; 7634126; 7719598. Additional U.S. and corresponding foreign patent
applications are pending.

Amnis, the Amnis logo, INSPIRE, IDEAS, and ImageStream, are registered or pending
U.S. trademarks of Amnis Corporation. All other trademarks are acknowledged.
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End User License Agreement

AMNIS CORPORATION SOFTWARE LICENSE AGREEMENT

PLEASE READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY
BEFORE DOWNLOADING, INSTALLING OR USING THE SOFTWARE OR ANY
ACCOMPANYING DOCUMENTATION (COLLECTIVELY, THE “SOFTWARE”).

THE TERMS AND CONDITIONS OF THIS SOFTWARE LICENSE AGREEMENT
(“AGREEMENT”) GOVERN USE OF THE SOFTWARE UNLESS YOU AND
AMNIS CORPORATION (“AMNIS”) HAVE EXECUTED A SEPARATE AGREE-
MENT GOVERNING USE OF THE SOFTWARE.

Amnis is willing to license the Software to you only upon the condition that you accept all
the terms contained in this Agreement. By clicking on the “I accept” button below or by
downloading, installing or using the Software, you have indicated that you understand this
Agreement and accept all of its terms. If you are accepting the terms of this Agreement on
behalf of a Company or other legal entity, you represent and warrant that you have the
authority to bind that Company or other legal entity to the terms of this Agreement, and, in
such event, “you” and “your” will refer to that Company or other legal entity. If you do not
accept all the terms of this Agreement, then Amnis is unwilling to license the Software to
you, and you must return the Software to Amnis for a full refund, if you have paid for the
license to the Software, or, if Amnis has made the Software available to you without
charge, you must destroy all copies of the Software. Your right to return the Software for a
refund expires 30 days after the date of purchase.

1. Grant of License. Conditioned upon your compliance with the terms and conditions of
this Agreement, Amnis grants you a non-exclusive and non-transferable license to Execute
(as defined herein) the executable form of the Software on a single computer, solely for
your internal business purposes. You may make a single copy of the Software for backup
purposes, provided that you reproduce on it all copyright and other proprietary notices that
are on the original copy of the Software. Amnis reserves all rights in the Software not
expressly granted to you in this Agreement. For purposes of this Agreement, “Execute”
and “Execution” means to load, install, and run the Software in order to benefit from its
functionality as designed by Amnis.

2. Restrictions. Except as expressly specified in this Agreement, you may not: (a) copy
(except in the course of loading or installing) or modify the Software, including but not lim-
ited to adding new features or otherwise making adaptations that alter the functioning of the
Software; (b) transfer, sublicense, lease, lend, rent or otherwise distribute the Software to
any third party; or (c) make the functionality of the Software available to multiple users
other than the users of the single computer for which it is licensed through any means,
including but not limited to uploading the Software to a network or file-sharing service or
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through any hosting, application services provider, service bureau, software-as-a-service
(SaaS) or any other type of services. You acknowledge and agree that portions of the Soft-
ware, including but not limited to the source code, file formats, and the specific design and
structure of individual modules or programs, constitute or contain trade secrets of Amnis
and its licensors. Accordingly, you agree not to disassemble, decompile or reverse engineer
the Software or data files, in whole or in part, or permit or authorize a third party to do so,
except to the extent such activities are expressly permitted by law notwithstanding this pro-
hibition.

3. Ownership. The copy of the Software is licensed, not sold. You own the media on
which the Software is recorded, but Amnis retains ownership of the copy of the Software
itself, including all intellectual property rights therein. The Software is protected by United
States copyright law and international treaties. You will not delete or in any manner alter
the copyright, trademark, and other proprietary rights notices or markings appearing on the
Software as delivered to you.

4. Term. The license granted under this Agreement remains in effect for a period of 75
years, unless earlier terminated in accordance with this Agreement. You may terminate the
license at any time by destroying all copies of the Software in your possession or control.
The license granted under this Agreement will automatically terminate, with or without
notice from Amnis, if you breach any term of this Agreement. Upon termination, you must
at Amnis’ option either promptly destroy or return to Amnis all copies of the Software in
your possession or control.

5. Limited Warranty. Amnis warrants that, for thirty (30) days following the date of pur-
chase (or delivery, if Amnis has made the Software available to you without charge), the
Software will perform in all material respects in accordance with the Documentation. As
your sole and exclusive remedy and Amnis’ entire liability for any breach of this limited
warranty, Amnis will at its option and expense promptly correct or replace the Software so
that it conforms to this limited warranty. Amnis does not warrant that the Software will
meet your requirements, that the Software will operate in the combinations that you may
select for Execution, that the operation of the Software will be error-free or uninterrupted,
or that all Software errors will be corrected. The warranty set forth in this Section 5 does
not apply to the extent that Amnis provides you with the Software (or portions of the Soft-
ware) for beta, evaluation, testing or demonstration purposes.

6. DISCLAIMER. THE LIMITED WARRANTY SET FORTH IN SECTION 5 IS IN
LIEU OF AND AMNIS EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES
AND CONDITIONS, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED
TO ANY IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT, AND
ANY WARRANTIES AND CONDITIONS ARISING OUT OF COURSE OF DEAL-
ING OR USAGE OF TRADE. NO ADVICE OR INFORMATION, WHETHER
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ORAL OR WRITTEN, OBTAINED FROM AMNIS OR ELSEWHERE WILL
CREATE ANY WARRANTY OR CONDITION NOT EXPRESSLY STATED IN
THIS AGREEMENT.

7. Limitation of Liability. AMNIS’ TOTAL LIABILITY TO YOU FROM ALL
CAUSES OF ACTION AND UNDER ALL THEORIES OF LIABILITY WILL BE
LIMITED TO THE AMOUNTS PAID TO AMNIS BY YOU FOR THE SOFTWARE
OR, IN THE EVENT THAT AMNIS HAS MADE THE SOFTWARE AVAILABLE
TO YOU WITHOUT CHARGE, AMNIS’ TOTAL LIABILITY WILL BE LIMITED
TO $100. IN NO EVENT WILL AMNIS BE LIABLE TO YOU FOR ANY SPECIAL,
INCIDENTAL, EXEMPLARY, PUNITIVE OR CONSEQUENTIAL DAMAGES
(INCLUDING LOSS OF DATA, BUSINESS, PROFITS OR ABILITY TO
EXECUTE) OR FOR THE COST OF PROCURING SUBSTITUTE PRODUCTS
ARISING OUT OF OR IN CONNECTION WITH THIS AGREEMENT OR THE
EXECUTION OR PERFORMANCE OF THE SOFTWARE, WHETHER SUCH LIA-
BILITY ARISES FROM ANY CLAIM BASED UPON CONTRACT, WARRANTY,
TORT (INCLUDING NEGLIGENCE), STRICT LIABILITY OR OTHERWISE, AND
WHETHER OR NOT AMNIS HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH LOSS OR DAMAGE. THE FOREGOING LIMITATIONS WILL SURVIVE
AND APPLY EVEN IF ANY LIMITED REMEDY SPECIFIED IN THIS AGREE-
MENT IS FOUND TO HAVE FAILED OF ITS ESSENTIAL PURPOSE.

8. U.S. Government End Users. The Software and Documentation are “commercial items”
as that term is defined in FAR 2.101, consisting of “commercial computer software” and
“commercial computer software documentation,” respectively, as such terms are used in
FAR 12.212 and DFARS 227.7202. If the Software and Documentation are being
acquired by or on behalf of the U.S. Government, then, as provided in FAR 12.212 and
DFARS 227.7202-1 through 227.7202-4, as applicable, the U.S. Government’s rights in
the Software and Documentation will be only those specified in this Agreement.

9. Export Law. You agree to comply fully with all U.S. export laws and regulations to
ensure that neither the Software nor any technical data related thereto nor any direct prod-
uct thereof are exported or re-exported directly or indirectly in violation of, or used for any
purposes prohibited by, such laws and regulations.

10. General. This Agreement will be governed by and construed in accordance with the
laws of the State of Washington, without regard to or application of conflict of laws rules or
principles. The United Nations Convention on Contracts for the International Sale of
Goods will not apply. You may not assign or transfer this Agreement or any rights granted
hereunder, by operation of law or otherwise, without Amnis’ prior written consent, and any
attempt by you to do so, without such consent, will be void. Except as expressly set forth in
this Agreement, the exercise by either party of any of its remedies under this Agreement
will be without prejudice to its other remedies under this Agreement or otherwise. All
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notices or approvals required or permitted under this Agreement will be in writing and deliv-
ered by confirmed facsimile transmission, by overnight delivery service, or by certified
mail, and in each instance will be deemed given upon receipt. All notices or approvals will
be sent to the addresses set forth in the applicable ordering document or invoice or to such
other address as may be specified by either party to the other in accordance with this sec-
tion. The failure by either party to enforce any provision of this Agreement will not con-
stitute a waiver of future enforcement of that or any other provision. Any waiver,
modification or amendment of any provision of this Agreement will be effective only if in
writing and signed by authorized representatives of both parties. If any provision of this
Agreement is held to be unenforceable or invalid, that provision will be enforced to the
maximum extent possible, and the other provisions will remain in full force and effect. This
Agreement is the complete and exclusive understanding and agreement between the parties
regarding its subject matter, and supersedes all proposals, understandings or com-
munications between the parties, oral or written, regarding its subject matter, unless you
and Amnis have executed a separate agreement. Any terms or conditions contained in your
purchase order or other ordering document that are inconsistent with or in addition to the
terms and conditions of this Agreement are hereby rejected by Amnis and will be deemed
null.

11. Contact Information. If you have any questions regarding this Agreement, you may con-
tact Amnis at 2505 Third Avenue, Suite 210, Seattle, WA 98121.

DURING INSTALLATION, IF YOU AGREE TO THE FOREGOING TERMS AND
CONDITIONS AND DESIRE TO COMPLETE INSTALLATION OF THE SOFT-
WARE, PLEASE CLICK THE “I ACCEPT” BUTTON. OTHERWISE, PLEASE
CLICK THE “I DO NOT ACCEPT” BUTTON AND THE INSTALLATION PROC-
ESS WILL STOP.

Disclaimers

The screen shots presented in this manual were created using the Microsoft® Windows®
XP operating system and may vary slightly from those created using other operating sys-
tems.

The Amnis® ImageStream® cell analysis system is for research use only and not for use in
diagnostic procedures.

Technical Assistance

Amnis Corporation
Seattle, WA
Phone: 206-374-7000
Toll free: 800-730-7147
www.amnis.com
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Welcome to IDEAS® 5.0
Welcome to the IDEAS version 5 application documentation for ImageStream and
FlowSight data analysis. IDEAS 5.0 or later versions are required to open FlowSight
data. Many new improvements have been added to the application.

How to use this manual
This manual provides instruction for using the Amnis IDEAS® application to analyze
data files from the Amnis ImageStream and FlowSight cell analysis systems.

The intuitive user interface of the IDEAS applicationmakes it easy for you to explore
and analyze data. The application can quantify cellular activity by performing sta-
tistical analyses on thousands of events and, at the same time, permit visual con-
firmation of any individual event. Furthermore, you can operate the application in a
batch processingmode and store specific analysis templates for either repeated use
or sharing with colleagues.

The fastest way to put the IDEAS application to work is to first skim through this
manual—becoming familiar with the application’s structure, compensation, file types,
and analysis tools—and then use the application wizards on some sample exper-
imental data to begin exploring the power that the application provides. This manual
has been integrated into the IDEAS application to provide searchable and context
sensitive help. Typing F1 while in the application opens the help files.

What's New in IDEAS 5.0
IDEAS 5.0 is required to analyze data from the FlowSight instrument and offers num-
berous improvements for analyzing data from any ImageStream instrument. Please
refer to the web site for the latest improvements and updates to this manual.

1. General
a. IDEAS 5.0 can be operated with a Standard User security profile.
b. New user Application Default settings include, directory updating, default

mask color and default statistics.
c. Files processed prior to 4.0 may not be able to be loaded in 5.0.

2. Data
a. Process FlowSight QI and non-QI files.
b. Read and analyze FCS files.
c. New template for finding features.
d. Faster processing and loading of data files.
e. Ability to use a FlowSight .rif file when selecting a compensation matrix.
f. Data loading and batching have been optimized to perform instrument cor-

rection and feature calculation at the same time.
3. Non-Quantitative Imaging (QI)

a. The FlowSight saves the compensation matrix and analysis template used dur-
ing acquisition as the default matrix and template in the .rif file.
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b. Combined feature calculation is enabled. No new feature or mask calculations
can be done without the QI upgrade.

c. The Start Analysis wizard steps you through the analysis of finding the single,
focused positive cells. Morphologically based wizards are not available with-
out the QI upgrade.

d. Compensation matrices may be applied to compensate Intensity features and
Images. All other features are not recomputed and are based on uncom-
pensated imagery.

e. Templates used for loading non-QI data files will load only the populations,
statistics and graphs for the features available and will not load those that
require the QI upgrade.

f. Non-QI files cannot be merged.
g. Creating data files from populations is not allowed.
h. Instrument segmentation masks are used and are not recomputed in IDEAS.

4. Features and Masks
a. The Gradient RMS feature has been improved. The range is now 0-100 and

will require region adjustment for files analyzed prior to IDEAS 5.0.
b. Improvements have been made to the default segmentation mask and align-

ment routine.
5. Image Gallery
6. User Interface

a. The statistics are now displayed in tables in the analysis area and the statistics
area has been removed.

b. Toolbars have been updated.
c. Analysis is started from the 'Start Analysis' button which goes right into the

Open file wizard and other available wizards depending on file type.
7. Sample Information

a. Added population statistics from the acquisition that reflect total counts and col-
lected counts in the sample.

8. Analysis Area
a. Tables for population statistics and object feature values are now available.
b. Selected panels can be resized, cut, copied or pasted. Selection of panels can

be done by clicking on the panel(s) or drawing a rectangle around the panels.
Control-click to add or remove panels from the selection.

c. Resize a panel by dragging the right or bottom edge or the lower, right corner.
Or choose the size (small, medium or large) in the toolbar.

d. Move a panel by click-dragging the title or copy and paste to new location.

Setting Up the IDEAS® Application
This chapter describes the hardware and software requirements for
the application, which includes the procedures for installing, remov-
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ing, and upgrading the application. The following subsections cover
this information:

“Setting Up the IDEAS® Application”

Installing the IDEAS® Application

“Setting Your Computer to Run the IDEAS® Application”

“Viewing and Changing the Application Defaults”

Hardware and Software Requirements
This section states theminimum and the recommended hardware and software
requirements for running the IDEAS application.

Hardware Requirements

Theminimum hardware requirements are 512MB of RAM and a 1-GHz processor.
However, due to the large size of the image files that the ImageStream cell analysis
system creates, a larger amount of RAM will prevent paging and thus increase per-
formance.

Software Requirements

IDEAS 5.0 64 bit version requires that theWindows 7 operating system be installed
on your computer. IDEAS 32 bit version requires Windows XP, Windows 2000 or
later version of the operating system. The latest service pack and any critical
updates for the operating systemmust be included. Youmust also install theMicro-
soft .NET Framework 2.0, which requires Microsoft Internet Explorer 5.01 or later.

Important: If the software requirements are not met, Setup will not block installation
nor provide any warnings.

Note that service packs and critical updates are available from theMicrosoft Secu-
rity Web Site.

Installing the IDEASApplication
If the IDEAS application has previously been installed, the previous version will be
removed during installation.

To install IDEAS software

1 Download the application Setup file from your account at www.amnis.com or
insert the CD or DVD that is labeled IDEAS application.

2 View the contents in My Computer orWindows Explorer.
3 Double-click Setup.exe.
4 Follow the instructions until the installation process has completed.
5 MadCap help viewer is installed and opened during installation or upgrade.
6 Select the language and check box to not show this dialog again.
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7 An icon appears on the desktop and IDEAS Application appears on the All Pro-
grams menu.

Setting Your Computer to Run the IDEAS® Application

Setting the Screen Resolution
Confirm that the screen resolution is adequate for the IDEAS application. To be able
to view the entire application window, youmust set the width of the screen res-
olution to aminimum of 1024 pixels.

To set the screen resolution

1 From the Start menu, select Control Panel, and then click Display.
2 Click the Settings tab to set the screen resolution.

Viewing File Name Extensions
When loading a file, the IDEAS application uses the file name extension to deter-
mine the file type. It will be easier for you to distinguish raw image files, com-
pensated image files, and data analysis files from each other if Windows Explorer
does not hide the extensions.

To view file name extensions

1 InWindows Explorer, go to Tools > Folder Options.
2 Click the View tab, andmake sure that the Hide extensions for known file types

check box is not selected.
3 Click OK.

Copying the Example Data Files
If the CD or DVD includes data files, copy them to a single directory on your hard
drive. Sample data files are also available on your workstation or at
www.amnis.com/login for customers with an Amnis account.

To copy the example data files

1 Copy the data files.
2 Right-click the directory that contains the data files, and click Properties.
3 Clear the Read-only check box.
4 Click OK.

Viewing and Changing the Application Defaults
To view or change these defaults, clickApplication Defaults on the Options menu,

• The Directories tab allows you to change the default Data, Template, Batch
or CompensationMatrix file directories and choose the option for updating the
location as you select files.
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• The Populations tab allows you to view or change the default color or symbol
for populations.

• TheMasks tab allows you to view or change the default mask color.

• The Statistics tab allows you to view or change the default list of statistics
shown for a graph.
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Overview of the IDEAS® Application
This chapter provides an overview of the IDEAS application user
interface, the files that the IDEAS application creates and uses, the
recommended directory organization and an overview of the work-
flow.

“Understanding the Data Analysis Workflow”

“Overview of compensation, analysis tools and file structure”

The Amnis cell analysis systems possess unique capabilities that neither flow
cytometry nor microscopy alone can deliver. The IDEAS application provides an
image gallery to view every cell in the data file along with linked graphical data for
confident gating and image confirmation. The application contains powerful algo-
rithms that facilitate and quantify the image analysis of ImageStream and FlowSight
QI data. Examples include the analysis of molecule co-localization and trans-
location, the analysis of cell-to-cell contact regions and signaling interactions, the
detection of raremolecules and cells, and a comprehensive classification of large
numbers of cells. The IDEAS application acquires data from INSPIRE™, com-
pensates the images, and allows the user to evaluate images with data analysis
tools. For more information about the QI and non-QI FlowSight data see the com-
parison table.

Comparing the FlowSight basic, Quantitative Imaging
and ImageStream data files

There are three types of instruments that collect data for Image Analysis in IDEAS:
The FlowSight without Quantitative Imaging (QI), The FlowSight with the QI upgrade
and the ImageStream. There are some differences in the available features and anal-
ysis that can be done. The table below outlines these differences.

FlowSight - basic FlowSight - QI ImageStream

Default template
INSPIRE features
and acquisition anal-
ysis

IDEAS default fea-
ture set - analysis

IDEAS default fea-
ture set - no analysis

Default compensation
matrix INSPIRE matrix No compensation No compensation

New feature calculation Combined features
only Unlimited Unlimited

User defined masks No Yes Yes

Default mask INSPIRE mask cal-
culated during acqui-

Default (Object)
mask computed in

Default (Object)
mask computed in

Data comparison
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FlowSight - basic FlowSight - QI ImageStream
sition IDEAS IDEAS

Wizards
Open File, Display
Properties and
Begin Analysis (2)

Complete set (10) Complete set (10)

Building blocks All All All
Merging files No Yes Yes

Compensation Intensity and
Images only

All features and
Images

All features and
Images

Create new files from
populations No Yes Yes

IDEAS Requires version
5.0.x

Requires version
5.0.x

Can open in 4.0 or
5.0

Sample Information
Populations tab:
populations and
counts

Populations tab: pop-
ulations and counts

Detection tab: cell
classifiers

.

Understanding the Data Analysis Workflow
Data analysis in IDEAS begins with opening a raw image file (.rif) that was collected
and saved using INSPIRE. Then, an existing compensationmatrix or a new com-
pensationmatrix is applied to the .rif file and two additional files are created, the .cif
(compensated image file) and .daf (data analysis file).

A compensationmatrix performs fluorescence compensation, which removes flu-
orescence that leaks into other channels. See “Overview of Compensation” for more
information about compensation. A compensated image can accurately depict the
correct amount of fluorescence in each cell image. Compensation is defined as the
correction of the fluorescence crosstalk. When creating the .cif the IDEAS appli-
cation also automatically performs corrections to the raw imagery using values
saved from the instrument at the time of data collection. These corrections include
flowspeed normalization, brightfield gains, and spatial registry.

A template is used to define the features, graphs, image display properties and anal-
ysis for the .daf. Within the .daf file, the user can perform many analyses using the
tools and wizards within the application and save the results as a template file (.ast).

The IDEAS application then calculates feature values and shows the data as spec-
ified by the selected template.

Once a data analysis file (.daf file) or compensated image file (.cif file) is saved, it
can be opened directly for data analysis. You would only open a .cif if you wanted to
change the template or a .rif file to change the compensation.

The diagram on the next page displays this workflow.
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Overview of Data Analysis Workflow

1 Create a compensationmatrix using the single color control files. Open an exper-
imental .rif file or from the Compensationmenu choose Create New Matrix.

2 A .cif and .daf file are automatically created. Analyze the experimental file using
data analysis tools in the .daf file to create an analysis template.

3 Create a statistics report table within the .daf file and save the data file, as an
anlaysis template.

Note: this is usually done on the positive and negative controls to create the appro-
priate analysis and then applied to the rest of the experimental files in the next step.

4 Perform batch processing, applying compensation and template files created
above.
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Overview of compensation, analysis tools and file struc-
ture

Data Acquisition and Compensation

Data Analysis Tools

Interface of the IDEAS Application

“Overview of the Data File Types”

Data Acquisition and Compensation
Data are first acquired from the instrument using the Amnis INSPIRE™ application.
Next, the IDEAS application processes and analyzes the image data. The IDEAS
application contains the algorithms and tools that are needed to analyze the imagery.
Preprocessing algorithms and tools correct for instrument biases, including flow-
speed variations, spatial alignments, illumination irregularities, and camera back-
ground. Compensation for spectral crosstalk is calculated from control files and
applied to experimental files. A compensationmatrix may be created on the instru-
ment during acquisition, see your INSPIRE or FlowSight user manual for details.

After the preprocessing completes, the IDEAS application allows for the inter-
rogation of the image data, segmenting out cells and other objects of interest. Using
a default template, the application calculates the values for standard features to be
used in subsequent analyses. Guided analysis for many common applications is
available through the use of wizards. Finally, the application displays imagery and
feature-calculation results, and it defines cell populations in a host of plots and his-
tograms.

Data Analysis Tools
Data in the IDEAS application can be further explored by using the data analysis
tools. For example, populations of cells can be identified by drawing regions on his-
tograms or scatter plots, or by tagging individual objects. The IDEAS application pro-
vides standard distribution statistics for all defined populations. In addition,with
FlowSight QI or ImageStream data users can further define images by creating fea-
tures—amathematical expression that contains quantitative and positional infor-
mation about the image.

The application also contains tools that allow you to view grayscale and pseudocolor
images, to apply gains and thresholds, and to build composite images. For individual
images, tools are available to examine pixel intensities, create line profiles of pixel
intensities, and compute the distribution statistics of the pixels in a region of an
image. Bothmorphological measurements and intensity information are available for
calculating feature values. Histograms and scatter plots display feature data graph-
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ically and the population distribution statistics include a variety of calculations such
as themean, standard deviation, and coefficient of variation (CV).

Interface of the IDEAS Application
The IDEAS Application allows the opening of multiple data files within one instance
of the program. Each file is divided into two sections: the ImageGallery and the Anal-
ysis Area. The placement and size of these areas are adjustable.

• The Image Gallery displays the images of populations of cells, segmentation
masks and composite images . For more information, refer to “Using the
ImageGallery”.

• The Analysis Areadisplays plots and distributions of cellular feature values.
Individual images, text panels and feature values for objects and populations
in tabular form. For more information, refer to “Overview of the Analysis Area”.

•

Overview of the Data File Types
Data from the Amnis cell analysis systems are collected andmanaged using three
types of data files: raw image file (.rif), compensated image file (.cif), and data anal-
ysis file (.daf).
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This section describes each file type and the table summarizes the features of each
file.

Raw Image File (.rif)

The INSPIRE application saves the digital image data, pixel intensities and location
that were acquired by the instrument to a .rif file.

A .rif file contains:

• Pixel intensity data (counts and location) that the camera collected for each
object that the instrument detected

• Instrument settings that were used for data collection.
• Calibration values from ASSIST.
• Compensationmatrix and template if used while acquiring FlowSight data.

Compensated Image File (.cif)

The IDEAS application creates a .cif file when the user opens a .rif file and applies a
compensationmatrix. The segmentation algorithm automatically defines the bound-
aries of each object, creating amask that is used for calculating feature values. The
applied compensationmatrix performs pixel-by-pixel fluorescence compensation
prior to segmentation.During the creation of the .cif file, the applicationmakes cor-
rections to the imagery. These corrections include:

• Removal of artifacts from variability in the flow speed, camera background,
and brightfield gains.

• Alignment of the objects to subpixel accuracy, which allows the viewing of
compensated imagery, composite imagery and the calculation of multi-image
feature values, such as the Internalization value.

• Coincident objects are cut apart to place into individual image frames. Note
that this will increase the number of objects in the file.

Multiple .cif files can be created from a single .rif file by applying a different flu-
orescence compensationmatrix or correction each time a .rif file is opened and
choosing a unique name for the .cif file. Similarly, you can create a new .daf file from
a single .cif file by creating a new name and applying a different analysis template.

Data Analysis File (.daf)

The IDEAS application creates a .daf file while it is loading a .cif file into a template
file (.ast). The .daf file is the interface to visualize and analyze the imagery that the
.cif file contains andmust reside in the same directory as the corresponding .cif file.

The .daf file contains:

• Feature definitions
• Population definitions
• Calculated feature values
• Image display settings
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• Definitions for graphs and statistics

Loading a .daf file restores the application to the same state it was in when the file
was saved, i.e., with the same views, graphs, and populations. In IDEAS versions
3.0 or later, a .daf file may be used as a template.

Note: When a .daf file is opened, the .cif file must be located in the same directory
as the .daf file since the .daf file points to images used for analysis that are stored in
the associated .cif file.

Template (.ast)

The IDEAS application saves the set of instructions for an analysis session in a .daf
file to a template (.ast file). Note that a template contains no data; it simply contains
the structure for the analysis. This structure includes definitions for:

• Features
• Graphs
• Regions
• Populations

The .ast also contains settings for:

• Image viewing
• Image names
• Statistics

The \templates subdirectory (under the directory where the IDEAS application
was installed) contains the default template, named defaulttemplate.ast. Because a
template is required for loading a .cif file, youmust use the default template to create
the first .daf file. After you save a custom template, you can use it for any sub-
sequent loads of .cif files.

Note: The default templatemay change between releases of the IDEAS application
software. In IDEAS versions 3.0 or later, a .daf file may be used as a template. The
default template contains over 200 calculated features per object. An expanded tem-
plate is also available that includes over 600 calculated features per object. The
FlowSight without the Quantitative Imaging upgrade has a limited set of features
available.

Compensation Matrix File (.ctm)

The IDEAS application saves the compensation values that are created and saved
during the spectral compensation of control files to a compensationmatrix file (.ctm
file). This file has no associated object data; it is created and saved to be applied to
experimental files. The compensationmatrix can be created in IDEAS using single
color control files after acquisition or during acquisition on a FlowSight. See the Flow-
Sight user manual for more information.
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File Acronym and
Name

File Creation Description

.rif
Raw Image File Created in INSPIRE

Contains instrument setup data, pixel intensity data,
and uncorrected image data from the INSPIRE appli-
cation. The IDEAS application uses the .rif file to create
a compensated image file (.cif file).

.cif
Compensated
Image File

User creates a .cif
from the .rif and .ctm

Contains imagery that has been corrected for variations
in the camera background, camera gains, flow speed,
and vertical and horizontal positioning between chan-
nels.
Serves as a database of images used for feature-value
calculations and imagery display.
The IDEAS application also performs fluorescence com-
pensation, if necessary, when creating a .cif file.
The IDEAS application loads the .cif file into a template
to create a data analysis file (.daf file)

.daf
Data Analysis File References the .cif

Themain working data file that contains the calculated
feature values, the graphs, and the statistics used for
analysis. The .daf file references the .cif.

.ast
Template File Created from the .daf

This file contains no data; it contains the structure for
the analysis, such as, definitions for features, graphs,
regions, and populations; image viewing settings;
image names; and statistics settings.

.ctm
Compensation
Matrix File

User creates new
.ctm when opening a
.rif or during acqui-
sition on a FlowSight

Contains compensation values that are created and
saved during the spectral compensation of control .rif
files. This file has no associated object data; it is
created and saved to be applied to experimental .rif
files.

Table 1: Review of Data File Types

Note about Case Sensitivity: Even thoughWindows does not treat file names as
case sensitive, the IDEAS application depends on the case-sensitive .rif, .cif, and
.daf file name extensions to identify the file types. Avoid the use of illegal characters
for file names such as: “\/:*?<>!”.
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Getting Started with the IDEAS Application
This chapter is divided into two sections. First, guided analysis is
described using the analysis wizards and second, advanced anal-
ysis with more detailed instructions that describe how to open, com-
pensate, merge, save, and create data files without using the
wizards. Building blocks are also discussed which provide a short
cut method to building commonly used graphs.

Guided analysis makes it easy to start analyzing your data. Once
you are familiar with the basic analysis available you may want to
perform more advanced analysis.

Note that data files from FlowSight without the Quantitative Imaging
upgrade have a limited feature set and limited wizard analysis.

General Outline of data analysis:
Note that these steps apply to any type of data analysis whether you use a wizard or
not.

1 Open one data file (the + or - control).
2 Create and save a compensationmatrix for the experiment.
3 Select focused cells.
4 Select single cells (or conjugates).
5 Select channels for subpopulationmarkers and gate to define subpopulations.
6 Gate on positive cells for the channels you wish to use for morphological anal-

ysis.
7 Find the feature that separates your populations (this may require opening both a

+ and - control) by using a wizard or themethod of finding a feature based on dis-
criminating tagged populations.

8 Refine the analysis and save the template.
9 Perform batch analysis on all data files in the experiment using the compensation

matrix and analysis template.

Guided Analysis
Data analysis always begins with opening a data file. The Start Analysis button will
step you through opening a file, setting the image display mapping and choosing an
analysis wizard.
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Application wizards are available to guide you through an analysis. The wizards can

be accessed from theGuided Analysis menu or the wizard tool or at the end of
the Start Analysis routine.

The following wizards are available:
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Application Wizards
General:

• “Open FileWizard:”
— Guides you through the process of opening a data file and setting image

display mapping in the image gallery.
• Display Properties:

— Sets image display mapping in the image gallery.

• Begin Analysis:
— Guides you through finding single, focused, positive cells.

Application specific:

• “Apoptosis Wizard”
— Guides you through the process of creating the features and graphs for

analyzing apoptosis.
• “Cell Cycle - Mitosis Wizard”

— Guides you through the process of creating the features and graphs for
analyzing the cell cycle and enumeratingmitotic events.

• “Co-localizationWizard”
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— Guides you through the process of creating the features and graphs for
analyzing the co-localization of 2 probes.

• “InternalizationWizard”
— Guides you through the process of creating the features and graphs for

analyzing the internalization of a probe.
• “Nuclear LocalizationWizard”

— Guides you through the process of creating the features and graphs for
analyzing the nuclear localization of a probe.

• “Shape ChangeWizard”
— Guides you through the process of creating the features and graphs for

analyzing the circular shape of a cell using a surface stain or brightfield
image.

• Spot Wizard
— Guides you through the process of creating themask, feature and graphs

for analyzing fluorescently labeled spots in images.

The wizard window is organized so that the instructions for each step are written in
the left side of the window, the stepwise progress through the wizard is shown in the
list on the right side and theremay be tips provided at the bottom of the window.
Click Next to progress through the wizard or Exit to stop at any time. Some steps
are optional and a Skip button is provided. Follow the instructions in the wizard to
complete an analysis.

Open File Wizard:
This wizard will guide you through the opening of a data file and setting the image dis-
play mapping. Use this wizard to open a file if you are not using one of the appli-
cation specific wizards.
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To begin, double-click onOpen File

Follow the instructions to open your file.

Tip: You can limit the view to specific file types (.daf, .cif or .rif) by using the drop-
downmenu ‘Files of type:’ in the Select Data File window.

A .daf file will open directly without further input, a .cif file will require a template and
a .rif file will require a template and a compensationmatrix. If the template or com-
pensationmatrix boxes are left blank, the default template and/or matrix will be
applied. For more information on opening data files see “Opening data files” .

Once a data file is open youmay begin analysis.

Display Properties Wizard
This wizard is automatically run when you use theOpen File wizard. It is also avail-
able to run in any open data file from theGuided Analysis menu or from the wizard
icon. This wizard will set the image display mapping for the channel images you
select and create a view of selected images. Brightfield and scatter images will be
automatically selected.

To begin, select wizards from theGuided Analyis menu or click the wizard icon in
the analysis area toolbar.

TheWizards window opens.
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Double-click on the Display Properties option and follow the instructions.

The Display Properties adjusts themapping of the pixel intensities to the display
range for optimizing the display and creates a view that includes the chosen chan-
nels. This is for display only and does not effect the pixel values. For more infor-
mation on image display see “Setting the ImageGallery Properties”“Setting the
ImageGallery Properties”.

Begin Analysis Wizard
This wizard is available once a data file is open and will guide you through choosing
the focused cells, then single cells, then choosing subsets of fluorescent positive
cells for phenotypic analysis before progressing on to amorphological analysis.

Open a data file using the Start Analysis button or by choosingWizards from the
Guided Analaysis menu. The wizards selection screen will appear once the data file
is open. If you have an open data file and want to access this wizard, chooseWiz-
ards from theGuided Analysis menu.
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To begin, double-click on Begin Analysis

Step 1. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 2. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 3. Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot to the analysis area. Click Skip if you do not
wish to use this step. Draw regions in the scatter plot to identify as many pop-
ulations as you want. This step will be repeated until you choose Skip or Finish.

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.

Apoptosis Wizard
The apoptosis wizard will guide you through the process of creating the features and
graphs tomeasure apoptosis using the images of the nuclear dye and brightfield.
Begin by opening a data file and then choosing the Apoptosis wizard.

To begin, double-click on Apoptosis

Follow the instructions to analyze your file.

Step 1. Select the nuclear image channel

From the drop downmenu pick the nuclear channel image.

Step 2. Gate cells in best focus
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A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulationmarker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Optional - Select additional subpopulation marker(s) OR. Gate
nucleated cells.

A histogram of the nuclear channel Intensity is added to the analysis area. Gate on
the positive events.

Next Step . Gate apoptotic cells

The nucleated cells scatter plot of the brightfield Contrast versus the Area of the
thresholded nucleus is added to the analysis area. Gate on the apoptotic cells with
low nuclear area and high brightfield contrast.
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The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.

Cell Cycle - Mitosis Wizard
The cell cycle - mitosis wizard will guide you through the process of creating the fea-
tures and graphs to analyze the cell cycle and identify mitotic events using the
images of a nuclear dye.

To begin, double-click on Cell Cycle - Mitosis

Follow the instructions to analyze your file.

Step 1. Select the nuclear image channel

From the drop downmenu pick the nuclear channel image.

Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the

- 20 -



Chapter 4

Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulationmarker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Optional - Select additional subpopulation marker(s) OR. Gate
G2/M cells.

A histogram of the nuclear channel Intensity is added to the analysis area. Gate on
theG2/M population with 2n DNA.

Next Step . Gate cells with condensed DNA

TheG2/M cells scatter plot of the threshold Area versus Bright Detail Intensity of the
nuclear image is added to the analysis area. Gate on the cells with condensed
nuclear that have low nuclear area and high Bright Detail Intensity values These will
include apoptotic cells which you can remove in the next step.

Next Step . Gate mitotic cells

The condensed DNA cells scatter plot of the brightfield Contrast versus the Area of
the thresholded nucleus is added to the analysis area. Gate onmitotic events with
low brightfield Contrast.

The final 3 plots are shown below:
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The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.

Co-localization Wizard
The co-localization wizard will guide you through the process of creating the features
and graphs tomeasure the co-localization of two probes in any population of cells
you identify.

To begin, double-click on Co-localization

Follow the instructions to analyze your file.

Step 1. Select the co-localization image channels

From the drop downmenus pick the two image channels that contain the co-local-
izing probes.

Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
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better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulationmarker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Gate double positives

A scatter plot of the last gated (or selected) population of the Intensity values for the
co-localization channels is added to the analysis area. Draw a region around the dou-
ble positive cells for the co-localizing probes.

Next Step. Gate co-localized events

A histogram of Bright Detail Similarity R3 for the double positive population is added
to the analysis area. Draw a region to gate on co-localized events.
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For amore thorough explanation of the Bright Detail Similarity feature see “Bright
Detail Similarity R3 Feature”

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.

Internalization Wizard
This wizard will create an analysis template for measuring the internalization of a
probe in any population of cells you identify.

To begin, double-click on Internalization

Follow the instructions to analyze your file.

Step 1. Select the internalization image channels

From the drop downmenus pick the cell image, the channel that defines the cell sur-
face, and the internalizing probe channel.

Step 2. Gate cells in best focus
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A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulationmarker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Optional - Select additional subpopulation marker(s) OR. Gate
internalization positives

A scatter plot of Max Pixel versus Intensity for the internalizing probe is added to the
analysis area. Draw a region to include the positive cells.

Next Step. Gate internalization events

A histogram of the Internalization feature for the positive cells is added to the anal-
ysis area. Draw a region to include the cells with high internalization. The example
below shows the internalization of labeled CpG (red).
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For amore thorough explanation of the Internalization feature see“Internalization
Feature”“Internalization Feature”

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.

Nuclear Localization Wizard
This wizard will create an analysis template for measuring the nuclear localization of
a probe in any population of cells you identify.

To begin, double-click on Nuclear Localization

Follow the instructions to analyze your file.

Step 1. Select the translocation image channels

From the drop downmenus pick the nuclear image channel and the translocating
probe image channel.

Step 2. Gate cells in best focus
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A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulationmarker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Gate double positives

A scatter plot of the last gated (or selected) population of the Intensity values for the
nuclear image and the translocating probe image is added to the analysis area. Draw
a region around the double positive cells.

Next Step. Gate translocated events

A histogram of Similarity of the double positive cells is added to the analysis area.
Draw a region to include the cells with translocation. Note that for a normally dis-
tributed population youmay want to report the RD of the double positive population
in a treated versus untreated sample instead of the percentage gated.

Nuclear localization of a probe is measured using the Similarity feature in the final
graph presented in the wizard. The example shown here is of THP1 cells stimulated
with 1 ug LPS for 90minutes and stained with DRAQ5 (red) and NFkB (green) to
measure the nuclear localization of the NFkB.
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For amore thorough explanation of the Similarity feature see “Similarity Feature” .

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.

Shape Change Wizard
This wizard will create an analysis template for measuring the shape (circularity) of
any population of cells you identify.

To begin, double-click on Shape Change

Follow the instructions to open and analyze your file.

Step 1. Select the cell morphology image channel

From the drop downmenu pick the channel for the cell image.

Step 2. Gate cells in best focus
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A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulationmarker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Gate fluorescence positives

A histogram of the last gated (or selected) population of the Intensity value for the
cell image is added to the analysis area. Draw a region around the double positive
cells. Note that this step is skipped if the cell image channel chosen is brightfield.

Next Step. Gate shape-changed events

A histogram of Circularity of the last gated population is added to the analysis area.
Draw a region to include the cells with low circularity scores.

Shape change is measured in the final graph presented in the wizard. Cells with low
circularity scores have a highly variable radius. In this examplemonocytes in whole
blood were stained with CD14 (green).
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For amore thorough explanation of the Circularity feature see “Circularity Feature” .

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.

Spot Wizard
This wizard will create an analysis template for measuring texture based on spot
counting. If the low and high spot count data are in separate data files merge the files
together before beginning.

To begin, double-click on Spot

Follow the instructions to open and analyze your file.

Step 1. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with
better focus have higher Gradient RMS, values. Begin your region at the bin after the
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Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 2. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Sin-
gle cells will have an intermediate Area value and a high Aspect Ratio. Click on the
dots to view the image associated with that dot. Note that the image is surrounded
by a light green line and the image next to it in the image gallery is not it's neighbor in
the plot. The images are presented in the order of acquistion.

Step 3. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Inten-
sity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the
number of times the subpopulationmarker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Select the spot image channel

From the drop downmenu choose the image channel for the spot counting.

Next Step. Assign truth populations

From the drop downmenus select two truth populations, one with high and one with
low spot count. To create the truth populations, either use the tagging tools or gate
the cells of interest.

Next Step. Gate spot events

A histogram of the Spot Count feature for the last gated population is added to the
analysis area. Regions have been drawn that include the truth populations. Adjust
the regions as necessary. Note that youmay want to adjust your truth populations
and repeat the wizard after looking at the images and validating the spot counts.
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The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.

Building Blocks:
Building blocks may be used to create a graph for finding single cells, focused cells
or positive cells based on Intensity. The building blocks are shortcuts to creating a
graph that provide a limited list of relevant features with set X and Y axis scales set
for the graph. For more information on creating graphs see “Creating Graphs”.

Building Block X axisFeatures Y axis Features
Flourescence Positives -
one color

Intensity_MC_ChX
(for all channels)

Flourescence Positives -
two color

Intensity_MC_ChX
(for all channels)

Intensity_MC_ChX
(for all channels)

Focus

Gradient RMS_MX_ChX
(for all channels)
Note: Gradient RMS of brightfield
is default

Single Cell

Area_brightfield (default)
Area_scatter
Intensity_MC_ChX
(for all channels)

Aspect Ratio_brightfield (default)
Aspect Ratio Intensity_MX_ChX
(for all fluorescence channels)
Intensity_scatter

Single Cell Default Area_brightfield Aspect Ratio_brightfield
Size/SSC Area_brightfield Intensity scatter

Table 1: Building blocks

To begin, choose Building Blocks from theGuided Analysis Menu or click on the
Building Blocks icon in the analysis area toolbar.
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The Building Blocks window opens. This window is used to define a graph with a
specified set of features available depending on the purpose of the graph.

1 Choose the specific Building Block from the drop-downmenu.

2 Choose the population(s) to graph.

3 Choose the X Axis Feature and the Y Axis feature, if applicable.
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4 Click OK.
5 The graph is added to the analysis area.

Advanced Analysis
“Opening data files”

Saving Data Files

“Overview of Compensation”

“Creating a New CompensationMatrix File”

“Viewing Sample Information”

“Merging Data Files”

“Creating New Data Files”

“Batch Processing”

Opening data files
Use the File menu, which is shown in the following figure, to open, save, and close
image and analysis files and to quit the IDEAS application. Alternatively, youmay
open a data file by drag and drop into an open IDEAS window. Muliple data files can
be open in one instance of the IDEAS application.
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Opening a .rif file

A .rif file is opened when there is new data and the IDEAS application needs to apply
corrections. When opening a .rif file, the IDEAS application corrects each image for
the spatial alignment between channels, camera background normalization, flow
speed, and brightfield gain normalization. If you want fluorescence compensation to
correct for spectral overlap, youmust create or choose a compensationmatrix at
this time by using the control files that were collected for a particular experiment. If a
FlowSight data file was acquired with a compensationmatrix, that matrix will be
used by default. For more information on compensation see “Creating a New Com-
pensationMatrix File”. The application performs the corrections by using calibration
information that was saved to the .rif file during acquisition.

To open a .rif file

To use a wizard to do this see “Open FileWizard:”, otherwise:

1 From the File menu, chooseOpen or drag the file into the IDEAS window.
2 Select the .rif file that you want in the Select File To Load window.
Tip: while browsing for the file to open you can limit the type of file shown in the win-
dow to .rif files.

In the next window you will:

• Choose a compensationmatrix
• Choose a template
• Name the output files
• Choose the number of events to process
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3 Click the folder next to Select a compensation matrix, compensated image
file, or data analysis file (.ctm, .cif, .daf) field to choose thematrix that was gen-
erated from the controls used for the experiment. If the .rif file contains a com-
pensationmatrix used during acquisition it will be entered into this box. If you
leave it blank, the default compensationmatrix will be used, but this is not rec-
ommended unless you do not want to compensate your data.
• If a compensationmatrix for the experiment has not beenmade, click New

Matrix. For more information on creating a compensationmatrix see “Creating
a New CompensationMatrix File”.

4 In the Select a template or data analysis file (.ast, .daf) field, select a tem-
plate file to load by clicking the folder and browsing for the file. If left blank, the
Default template with the basic features, masks, and settings will be used. Flow-
Sight files use the acquisition template as the default.

5 Name the output files with a new name, if necessary.
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6 Youmay change the number of objects to load in the box under Enter the
number of objects to process. The default value is the number of objects in the
file.
Tip: you can select a smaller number than themaximum if you have a large
number of objects to load. This helps save time for creating a template file. The
IDEAS application randomly loads the specified number of objects within the file.

7 Click OK.
The application then creates the .cif and .daf files and the .daf file is loaded into
the Image Analysis area.

.Rif File Option: Setting Advanced Corrections

Most often, the defaults will be adequate. For some older data files, youmay need to
provide control files for certain settings. For assistance call Amnis application sup-
port.

• To view the corrections that will be applied to the .rif file, click Advanced
within the Opening a .rif file window.
TheOpening file window appears.

• Make any changes to the corrections that you need, and then click OK.

Opening a .cif file

A .cif file is generated when corrections are applied to a .rif file, as described in “Over-
view of the Data File Types”. When opening a .cif file, the IDEAS application cal-
culates feature values and creates a .daf file to display images and graphs.

When opening a .cif file, an analysis template is selected. The template provides the
initial characteristics of the analysis. Opening the .cif file causes the IDEAS
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application to calculate feature values and to use populations, graphs, and image
viewing settings to display the cells as defined by the template.

To open a .cif file

To use a wizard to do this see “Open FileWizard:”, otherwise:

1 From the File menu, chooseOpen or drag the file into the IDEAS window.
2 Select the .cif file that you want in the Select File To Load window.
Tip: while browsing for the file to open you can limit the type of file shown in the win-
dow to .cif.

In the next window you will:

• Choose a template
• Name the output file
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3 Click the folder next to Select a template or data analysis file (.ast, .daf) and
choose the template to use for analysis. If left blank, the IDEAS application will
use a default template. However, it is useful to create and save your own tem-
plates for specific experimental procedures.

4 Change the Data analysis file name, if necessary. The default namematches
the name of the .cif.

5 Click OK.
During the opening of a .cif file, the IDEAS application calculates the values of
the features that are defined in the template you selected. The progress is shown
by a progress bar. After the application has successfully opened the .cif file, the
.daf file is saved.
See also: “Saving Data Files”.

Opening a .daf file

A .daf file contains the calculated feature values so that they will not need to be recal-
culated, as described in “Overview of the Data File Types”. To open a .daf file, the
IDEAS application requires the .cif file to reside in the same directory. The .daf file
does not contain any image data, so you can think of the .cif file as the database that
contains the imagery. Because all of the feature values have been saved in it, the
.daf file should open quickly.

To open a .daf file

To use a wizard to do this see “Open FileWizard:”, otherwise:

1 From the File menu, chooseOpen or drag the file into the IDEAS window.
2 Select the .daf file that you want in the Select File To Load window.
Tip: while browsing for the file to open you can limit the type of file shown in the win-
dow to .daf.
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The progress is shown by a progress bar. The state of the IDEAS application is
restored to what it was when the .daf file was saved.

Saving Data Files
Data files are saved at several stages of analysis. Raw image files are saved during
data acquisition, by mergingmultiple .rif files or by creating new files from pop-
ulations. Compensated image files and Data analysis files are saved when opening
.rif files, mergingmultiple .cif files, or when running a batch analysis. The IDEAS
application also saves other types of files that are used for data correction and pre-
sentation. Template files (.ast) save the structure of an analysis and compensation
matrix files (.ctm) save the compensationmatrices.

Application Defaults are set that direct the files into specific folders and can be
viewed or changed by the user. See “Viewing and Changing the Application
Defaults” for more information.

Saving a Data Analysis File (.daf)

A .daf file contains a snapshot of an analysis as described in “Overview of the Data
File Types”. Saving the analysis as a .daf file allows you to recall that analysis
simply by opening the file. When you quit the IDEAS application, you are always
prompted to save changes to a .daf file. You can also save changes from the File
menu. Remember that the .daf file does not contain image information, so opening
the .daf file requires the related .cif file to reside in the same directory.

To save a .daf file

1 On the File menu, click Save as Data Analysis File (.daf).
2 Enter a file name. Note that the default directory is the one where the .cif file was

saved.
If you select an existing file name, a warning appears that asks you to verify the
overwriting of the existing file.

3 Click Save.
The data is now ready for analysis. You can create graphs, view imagery, and dis-
play feature values and statistics. After you have defined an analytical procedure
in the .daf file, you can save the file as a template, which allows you to use the
procedure for analyzing other files. Refer to “Overview of the Data Analysis
Tools” for more information.

option: Saving a data analysis file with only the feature values used.

When you want to reduce the size of a data analysis file youmay save the .daf with
only the features that are used for analysis of statitics or graphs.

On the File menu, click Save as Data Analysis File - Used Features Only. and follow
the instructions 2-3 above.
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Saving a Compensated Image File (.cif)

The IDEAS application creates and saves a .cif file when a .rif file is opened. By
default, the application names the .cif file with the same name that the .rif file has,
replacing the .rif extension with .cif. The application also places the .cif file in the
same directory as the .rif file. The .cif file will be larger than the .rif file because the
.cif file contains masking information as well as corrected and/or compensated
images.

Saving a Template (.ast)

Saving an analysis as a template allows you to apply the structure of the analysis to
other .cif files. Save a template file after saving a .daf file. A template includes all
graph definitions, ImageGallery settings, feature definitions, and statistics settings.
No data are saved in a template. Therefore, selected images and populations that
are dependent on specific objects, such as tagged populations, are not saved.

To save a template

1 On the File menu, click Save As Template File (.ast).
A Save File dialog box appears.

2 Enter the name of the file to save.
3 Click Save.

If you select an existing file name, a warning appears that asks you to verify the
overwriting of the existing file.
Tip: You can change the default template directory in themenu Analysis > Appli-
cation Defaults.

Overview of Compensation
Spectral compensation corrects imagery for fluorescence that leaks into nearby
channels so that youmay accurately depict the correct amount of fluorescence in
each cell image.

For example, the light from one fluorochromemay appear primarily in channel 3, but
some of the light from this fluorochromemay appear in channel 4 as well, because
the emission spectrum of the probe extends beyond the channel 3 spectral band-
width. The light from a second fluorochromemay appear primarily in channel 4 but,
unless you subtract the light emitted by the first fluorochrome into channel 4, you
cannot generate images that accurately represent the distribution of the second fluor-
ochrome.

Emmission Spectra for two fluorochromes:
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Below is an example of cells stained with two fluorochromes independently and run
together as one sample. Intensity scatter plots and images are shown uncom-
pensated and compensated. Image compensation is performed on a pixel by pixel
basis.

Uncompensated Compensated
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The IDEAS application builds amatrix of compensation values by using one or more
control files. A control file contains cells stained with one fluorochrome. Because it
is critical that matrix values be calculated from intensities derived from a sole source
of light, control files are collected without brightfield illumination, or scatter. The
IDEAS application performs brightfield compensation when it loads a .rif file. The
process of creating the compensationmatrix is described in the next section.

Preview and edit a compensation matrix

A compensationmatrix can be applied to a population or .rif file in a preview mode for
editing amatrix.

To open a compensationMatrix

1 Select View/Edit CompensationMatrix from the Compensationmenu to view,
edit or preview thematrix on image data.Select the data file by clicking on the
folder and then click Open. Thematrix values are displayed in a table andmay be
edited.

2 To preview thematrix on image data, browse for a file or select a population from
the current file to preview and click Preview.

Note: It is recommended that you first create a small tagged pop-
ulation to preview compensation changes because previewing large
populations requires a lot of memory andmay be slow.

3 Youmay repeat editing thematrix and previewing until satisfied.
4 When done, click OK and save thematrix.
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Merging Data Files

Merging Raw Image Files

You canmerge .rif files together for analysis.This option is not available for basic
FlowSight files without the Quantitative Imaging (QI) upgrade.

Tomerge .rif files

1 On the Tools menu, click Merge .rif Files.
TheMerge Raw Image Files window appears.

2 To select the .rif files to merge, click Add Files.
The .rif file names appear in the list.

3 If you want to remove a file from the list, select it and then click Remove File.
4 When themerge list is complete, click OK.

The Save Merged Raw Image (.rif) File dialog box appears.
5 Type a unique file name.
6 Click Save.

The Creatingmerged .rif file window appears.

When themerge is complete, theMerged .rif Created message appears.
7 Click OK.

Note: The sample information will contain the classifier information for the first
file in themerge list however the classifier is turned off when amerged file is
loaded. To turn the classifier onmanually, go to the Advanced panel on the open
.rif window when opening amerged file.

Merging Compensated Image Files

You canmerge .cif files together for analysis.This option is not available for basic
FlowSight files without the Quantitative Imaging (QI) upgrade.
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Tomerge .cif files

1 On the Tools menu, click Merge .cif Files.
The Load Multiple .cif Files window appears.

2 To select the .cif files to merge, click Add Files.
The .cif file names appear in the list.

3 If you want to remove a file from the list, select it and then click Remove File.
4 Type a unique name for the output files.
5 Select a template..
6 Click OK.
7 Themerged files are created and the new .daf file is loaded with a population

created from each file.

Creating New Data Files

Creating new data files from populations

To further analyze a population or merge it with other data when working in a .daf,
you can save it to a new data file. This course of action is useful if your data file con-
tains a large number of objects that are not pertinent to your experiment. Decreasing
the data file size results in better performance by the IDEAS application, as
described in “Creating Regions onGraphs”. Note that you cannot create a new .cif or
.rif whenmultiple data files are open. This option is not available for basic FlowSight
files without the Quantitative Imaging (QI) upgrade.

To create data files from populations

1 On the Tools menu, click Create Data File from Populations.
The Create .cif and/or .rif From Populations window appears.
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2 In the Select populations list, select the populations that you want to include in
the new data file(s). Ctrl click to select multiple populations.

3 To create a .rif file, select the New Raw Image File (.rif) check box, the pop-
ulation name is used as a default. Youmay enter a new name.

4 To create a .cif file, select the New Compensated Image File (.cif) check box,
the population name is used as a default. Youmay enter a new name.

5 Click OK.
If you created a new .cif file, you can choose to load it. When loading the .cif file,
the application will prompt you for the template.

Viewing Sample Information
All of the information associated with an IDEAS file, such as the collection infor-
mation, camera settings and corrections, is saved within IDEAS and can be viewed
in the Sample Information window.

To open the Sample Information window

1 Go to Tools > Sample Information to open the window.
Information for the open data file will be loaded. You can browse for a data file by
clicking on the folder. You can open the Sample InformationWindow for any of
three file types: .rif, .cif, or .daf.

2 Select a Tab to see the information for each heading.
3 Click Print to print a report of all of the sample information.

Tip: Youmay click on the folder and browse for a file to view the sample information
for any file without loading the file.
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Acquisition tab: File names, software version numbers, date acquired, number of
objects, sample name.

Corrections tab: Camera background, alignment offsets (from ASSIST).

Focus/Fluidics tab: Core information and sample volume.

Detection tab:ImageStreamX only. Cell classifier settings during acquisition.

Population tab: FlowSight only. Lists the populations and number acquired.

Camera Settings tab: Binmode, magnification and sensitivity settings.

Illumination tab: Brightfield and laser information.

EDF tab: View kernels used for deconvolution of EDF imagery.

Compensation tab: View the compensationmatrix.

Channels tab: Lists channels collected.

Batch Processing
Batch processing allows you to automatically analyze a group of files with one tem-
plate when a compensationmatrix has already been generated for the experiment.

To perform batch processing

1 On the Tools menu, select Batch Data Files.
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The Batches window appears. It lists a record of all batches you have proc-
essed.

2 Click Add Batch.
The Define a Batch window appears.
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3 To select the files for the batch, click Add Files. Navigate to the files and select
by clicking on the file. Select multiple files to add by holding down the Ctrl key
while selecting the files.
• To remove files from the Files to Process list, click Remove Files.

4 Select a compensationmatrix from a file (.ctm, .cif, or .daf).
5 Select a template file (.ast or .daf). Leave blank to use the Default template.
6 Set the output files parameters.
7 If the template contains a Statistics Report template click on the Preview Sta-

tistics Report button. Order the files as you wish them to be reported by select-
ing a file with a left-click, then right-click the desired position and select ‘move
here’. See “Reporting Statistics” for more information.

8 Click OK.
The Define a Batch window closes. The batch appears in the Batches window.
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9 The Batches window offers the following options:
• Add Batch: If you want to create another batch to add to the list.
• Remove Batch: If you want to remove a batch from the Batches to Run list.
• Edit Batch: If you want to edit a batch in the Batches to Run list.

10 When you are satisfied with the Batches to Run list, click Submit Batches.
The files to process are listed and the progress is displayed in the Processing
Batch window. Once you have started processing batches, it may use up a fair
amount of your computer’s processing power.

Tip: To cancel the batch processing at any time, click Cancel Batch. The
IDEAS application will confirm cancellation and complete the file it is working on.
When the batch processing is complete, the IDEAS application saves the .rif,
.cif, and .daf files in the batch results directory. In the Batches window, a list of
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processed batches appears in the Processed Batches list. If a batch did not suc-
cessfully complete, it will appear in red.
Tip: To display the error that occurred during processing, double-click the batch.

11 If you want a batch report, double-click the batch in the Processed Batches list of
the Batches window.
The Batch Results window appears.

12 In the Batch Results window, click Print.
13 In the Batch Results window, click Close.
14 In the Batches window, click Close.

Overview of the Data Analysis Tools
The IDEAS application provides a powerful tool set that allows you to explore and
analyze data. The rich feature set lets you create hundreds of your own features to
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differentiate objects and statistically quantify your results.

As shown in the following figure, the application window is divided into two panels—
the ImageGallery and Analysis Area—which each provide the corresponding tools
that you can use for data analysis. The layout can be changed to side by side or top
and bottom with resizable panels.

You can create populations of objects by tagging hand-selected images, drawing
regions on graphs, and using Boolean logic to combine existing populations. After
you have created a population, you can view it in the ImageGallery or plot it on a
graph. You can view the statistics for populations or objects in tables placed in the
analysis area.

Graphs show data plotted with one or two feature values, and tools are provided that
allow you to draw regions for the purpose of generating new populations. You can
show any population on a plot.

Every image is linked to the feature data. Selecting an individual data point in a graph
allows you to view it in the ImageGallery or look at its feature values in the Statistics
Area. Any object that is selected in the ImageGallery is also shown on the plots in
the Analysis Area.
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Using the Image Gallery
This section contains the following subsections, which describe how to view pop-
ulations of objects in various ways, view masks, customize the ImageGallery dis-
play, and hand-select objects for a population:

“Using the ImageGallery”

“Setting the ImageGallery Properties”

“Working with Individual Images”

“Creating Tagged Populations”

Overview of the Image Gallery

The ImageGallery displays the imagery andmasks of any population of objects.

A toolbar is provided in the upper-left corner of the panel, as shown in the following
figure. The ImageGallery alsomakes different viewingmodes available for the
imagery. The default template contains the viewingmodes which allows you to view
all channel images in grayscale or color, or each channel image individually.

Tip: You can build custom viewingmodes as shown in this example. For more infor-
mation, see “Setting the ImageGallery Properties”.
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Image Gallery Tools

Tool Description

TaggingMode Tool

Allows you to create a population of hand-
picked objects. See: “Creating Tagged Pop-
ulations”.

ImageGallery Properties Tool
Provides custom display features. See: “Set-
ting the ImageGallery Properties”.

Show SegmentationMask Tool
Displays masks on the imagery. See:
“Using the ImageGallery”.

Show Color Tool
Sets the ImageGallery color. See: “Using
the ImageGallery”.

Show Saturation Color Tool

Click on the tool and it will show any sat-
urated pixels will turn red. See: “Using the
ImageGallery”.

Zoom Tools Zoom in or out and reset zoom on the image
gallery. See: “Using the ImageGallery”

Table 1: ImageGallery Tools

To view the imagery for a population

1 In the Population drop downmenu of the ImageGallery, click the population that
you want. (The list includes all the populations as well as the currently selected
bin from a histogram.) To create a population, refer to “Creating Tagged Pop-
ulations”.

2 To select an individual image, click on it. A thin, green frame indicates the
selected object.
• The object’s feature values are displayed in a table if an object is selected and

a table is added to the Analysis Area.
• The selected object is identified in each scatter plot graph with a green cross.
• The image can be placed in the Analysis area by right click>Display Single

Image.
Tip: Conversely in any scatter plot in the analysis area, clicking a graphical
point causes the ImageGallery to highlight and display the corresponding
object.
Note that the objects are presented in the Image Gallery in the order of acqui-
sition and are not necessarily near each other in a scatter plot.

To change the viewingmode

• In the View drop downmenu of the ImageGallery, select a specific view. The
imagery display changes according to the new view.

To show or hidemasks

• Click the Show Segmentation Masks toolbar button to toggle between show-

ing and hiding the selectedmasks for all images in the ImageGallery .
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Themask is shown as a transparent layer over each image. Themask dis-
played is selected in the ImageGallery Properties View tab. The color of the
overlayedmask can be changed in the Applications Defaults under the
Options menu.

Tip: To hide themask for a specific channel only, set the individual channel
mask to None.

To show or hide color

• Click the Show Color toolbar button to toggle between showing and hiding
the colors for all images in the ImageGallery. See “Setting the ImageGallery
Properties” for more information.

To zoom on the image gallery

• Click the Zoom In toolbar button to view the images in the gallery closer and
the ZoomOut or Reset Zoom to reverse the zoom.

•

To show saturation

• Click the Show Saturation Color toolbar button.

Saturated pixels in images, if any, appear in red.

Setting the Image Gallery Properties

When a new data file opens in the default template, youmight find it difficult to
clearly see cell morphology because the ImageGallery display properties have not
yet been properly adjusted for the data set.

To optimize the display youmay use the wizard “Display Properties Wizard” to set
the pixel intensity mapping to the display range. Manual adjustment and other set-
tings are described below.
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Clicking the Image Gallery Properties toolbar button opens the ImageGallery Prop-
erties window, which contains the following tabs:

• Display Properties—Allows you to define the name, color, and display inten-
sity mapping for each image. Allows adjustment of the image size for the
image gallery.

• Views—Allows you to customize the views for the ImageGallery.
• Composites—Allows you to create composites and adjust the amount of color

from a channel that is included in a composite image.

To customize the ImageGallery display properties

1 Click the Image Gallery Properties toolbar button to begin.

The Image Gallery Properties window appears with the Display Properties
tab displayed.

To change the size of the panels in the image gallery

1 Display Width and Display Height can be specified or changed to Auto Fit in the
lower left section of this window.

To change the name or color for each image

- 56 -



Chapter 4

1 Select an image in the list of images on the Display Properties tab of the Image
Gallery Properties window.

2 On the right side of the window you can type a new, unique name for the selected
image. Note that each image is provided with a default name and the image
names appear near the top of the ImageGallery.

3 Click the colored square for the selected image.
4 Click the color that you want in the color palette.
5 Click OK to close the palette.

Tip: The grayscale image in each channel is assigned a default color for image
display in the gallery. Setting the color to white is equivalent to using the original
grayscale image. The colors are also used to build composite images.

To fine-tune the image display intensity for an image

1 On the Display Properties tab of the Image Gallery Properties window, select
an image by clicking the image name in the list. The graph for the currently
selected image is shown in the window and updates as the changes aremade.
Select and image in the image gallery that has intensities for the image channel
you are adjusting.
Note: You will adjust the Display Intensity settings on the graph (the Y Axis),
the value of the display to (the X axis), the range of pixel intensities. The range of
pixel intensities will depend on the instrument and the collectionmode set during
acquisition. The display range is 0–255; the range of intensities from the camera
is 0-4095 for the ImageStreamX or 0-32,767 for EDFmode collection. The IS100
first generation instrument has a 10 bit camera and therefore the range of pixel
intensities is 0–1023. The limits of the graph enable you to use the full dynamic
range of the display tomap the pixel intensities of the image.

At each intensity on the X Axis of the graph, the gray histogram shows the
number of pixels in the image. This histogram provides you with a general sense
of the range of pixel intensities in the image. The dotted green linemaps the pixel
intensities to the display intensities, which are in the 0–255 range.
Manual setting is done by Click-dragging the vertical green line on the left side
(crossing the X Axis at 0) allows you to set the display pixel intensity to 0 for all
intensities that appear to the left of that line. Doing so removes background noise
from the image.
Click-dragging the vertical green line on the right side allows you to set the dis-
play pixel intensity to 255 for all intensities that appear to the right of that line.
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2 From the ImageGallery window, select the object to use for setting themapping.
It appears in the ImageGallery Properties window.
Tip: Youmight need to select different objects for different channels because an
object might not fluoresce in all channels.

3 To adjust the pixel mapping for display, click-drag the vertical green line by click-
ing near it (but not near the yellow cross).
Tip: For fluorescence channels, set the vertical green line that appears on the left
side to the right of the large peak of background pixel intensities as shown above
and set the right vertical green line to the right of the brightest pixel intensities.
Click 'Set Linear Curve' to make the transformation linear. For the brightfield
channel, set the vertical lines to about 50 counts to the right and left of the his-
togram to produce an image with crisp brightfield contrast.
• To change themapping curve to be logarithmic or exponential, click-drag the

yellow cross.
• To restore themapping to a linear curve, Click Set Linear Curve.
• To see the full scale for the X Axis Click Full Scale.
• To set the display mapping of the X Axis to the lowest and highest values for

a selected object, Click Set Range to Pixel Data.
• To set the scale of the X Axis to the range of the vertical green lines or of all

the pixel intensities for the selected object—whichever is larger—Click Auto-
scale.

• Youmay enter values manually by selecting theManual tab.

4 If you want to preview the changes in the ImageGallery, click Preview
Changes in Gallery.

5 Continue customizing the ImageGallery display properties with another pro-
cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

To customize the ImageGallery views images andmasks

1 Within the Image Gallery Properties window, click the Views tab.
Note: The ImageGallery view can be customized to view any combination of
channel images or composites. The default view All Channels is a view that
displays all image channels that were included during acquisition of the file
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with their associated default masks. This mask may be changed for the
default view however, the images in this view cannot be changed.

The list of existing views is shown on the left.

2 To create a new view, Click New. The new view is automatically added to the list
on the left.

3 In the right section of the window, type in a name for the view.
4 Click Add Column.
5 Define the column by selecting an image and amask or a composite from the

dropdownmenu.
6 Repeat the previous 2 steps until finished adding columns to the view. A column

will be added under the column currently selected. To insert a column click on the
image above insertion point.

7 Columns may be removed by clicking on Remove Column.
8 A view may be edited at any time by selecting the view and following the same

procedures.
9 If you want to delete a view, click the view to select it, and then click Delete.

A confirmation window appears.
10 If you want to preview any new changes in the ImageGallery, return to the Image

Gallery and choose your new view in the View drop downmenu. Then return to
the Image Gallery Properties window and click Preview Changes in Gallery.

11 Continue customizing the ImageGallery display properties with another pro-
cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

To create a composite

1 Within the Image Gallery Properties window, click the Composites tab.

The list of existing composites is shown on the left.
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2 In the right section of the window, type a name for the composite or leave blank
to allow the name to be built automatically from the image names added to the
composite.

3 Click Add Image. The selected image appears in the Object box. Change the
Percent if desired. The percent specifies the percentage of of the image to
include in the composite.
Tip: As youmake the changes, the image in the Object box updates accordingly.
If you want to preview any new changes in the ImageGallery, return to the Image
Gallery and select the View drop downmenu to your new view. Then return to the
Image Gallery Properties window and click Preview Changes in Gallery.

4 Continue to add images as desired.
5 To remove and image from the composite, Click Remove Image.
6 The composite is automatically added to the list on the left.
7 A composite can be removed from the list by clicking Delete.
8 Continue customizing the ImageGallery display properties with another pro-

cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

Working with Individual Images

You can work with individual images in the ImageGallery. You can zoom in or out on
the images. You can add a larger version of an image to the Analysis Area for further
analysis, show or hidemasks for a single image in the ImageGallery, and copy one
or more images to the Clipboard.

Tomanipulate individual images

1 In the ImageGallery, right-click an image that you are interested in.
A menu appears.
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• To place the image in the Analysis Area, click Add Image to Analysis Area.
(For more information, see “Analyzing Individual Images”.)

• To show or hide themasks for the object image, click Show Masks or Hide
Masks, respectively. (One or the other will appear depending on the current
state.)

• To turn the colors on or off for the object image, click Color On or Color Off,
respectively.(One or the other will appear depending on the current state.)

• To show or hide the saturation color for the object image, click Show or Hide
Saturation Color respectively.(One or the other will appear depending on the
current state.)

To copy images for use in reports

1 In the ImageGallery, right-click an image that you are interested in.
A menu appears.

• To copy the single channel image to the Clipboard, click Copy Image to Clip-
board.

• To copy all of the channel images of 1 object to the Clipboard, click Copy
Object Images to Clipboard.

• To copy the single channel image for all of the displayed images to the Clip-
board, click Copy Gallery Column to Clipboard.

• To copy all the visible images in the ImageGallery to the Clipboard, click
Copy Gallery to Clipboard.

Overview of the Analysis Area
The Analysis Area provides display space for individual images, plots of cellular fea-
ture values, tables of population statistics, tables of object feature values, and text
annotations. You can select different layouts for the IDEAS window and placement
of the analysis area and expand the Analysis Area by dragging it’s boundaries.
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The graphs are created into panels of a default size and can be re-sized by dragging
a corner or using the size tool. The position of the panels is automatically adjusted to
fit in the available display space. A vertical scroll bar appears when the number of
panels exceeds the space available on the window. The panels can be re-tiled using
the arrange analysis area tool.

As illustrated by the following figure, the Analysis Area can contain several types of
panels: histogram, histogram overlay, scatter plot, tables of population statistics or
object feature values, channel image, composite image, and text. Each panel will
contain its own toolbar and context menu. Tomove a panel click on the name at the
top of the graph and drag it to a new location. A graphmay be selected and then a
right click in a blank space in the work area allows you to choose paste in the new
location.

A toolbar is visible at the top of the Analysis Area. The following table describes the
function for each tool.

Analysis Area Tools

Tool Description

Pointer Tool

Provides the normal mode of interaction with the graphs. Clicking a point
on a scatter-plot graph causes the IDEAS application to display the cor-
responding image in the ImageGallery (if the population that is currently
displayed in the ImageGallery contains that point).
Click the bin in a histogram to select the bin. In the ImageGallery, you
can view images of cells in the bin by choosing the Selected Bin pop-
ulation.
Click Pointer Tool while drawing a region on a graph to cancel the cre-
ation of a region.

Tagging Tool
Allows you to create a population of hand-picked objects. For more infor-
mation, see “Creating Tagged Populations”.

New Histogram Tool Creates a new histogram.

New Scatter Plot Tool Creates a new scatter plot. Refer to

Table 1: Analysis Area Tools
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Tool Description

Populations Statistics
table

Creates a table to display population statistics.

Object Feature Values
table

Creates a table to display selected object feature values.

Text Tool
Allows user to add text notes to the Analysis Area. Refer to “Adding Text
to the Analysis Area”.

Line Region Tool

Draws a horizontal line on a histogram to define a region.

Rectangle Region Tool Draws a rectangular region on a scatter plot.

Oval Region Tool Draws an oval region on a scatter plot.

Polygon Region Tool

Draws a polygon region on a scatter plot graph. Each click starts a new
segment in the polygon until the entire image is double-clicked to com-
plete the region.

Wizards Tool
Short-cut to usingWizards for guided analysis.

Building Blocks Tool
Short-cut to using Building Blocks for guided analysis.

Select All Tool Selects all panels in the analysis area.

Tile Graphs Tool
Tiles graphs in the analysis area after changing the size of the analysis
area to fit all graphs to the new space.

Layout Tools Switches the layoutof the image gallery and analysis area.

Graph Bkgd Tool
Changes the background of the graphs to black or white.

Graph sizing
Tools

Changes the size of selected graphs to small, medium or large.

Creating Graphs

You can add two types of graphs to the Analysis Area:

• Histogram—Graphs a single feature.
• Scatter Plot—Graphs two features.

Note that building blocks are available that will help you to create graphs for finding
single, focused or fluorescent positive events. See Building Blocks.

To create a graph

1 Click the New Histogram or New Scatter Plot toolbar button.

The New Histogram or New Scatterplot window appears, respectively.
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2 Select the one or more populations to graph by clicking them. To select more
than one population, use the Ctrl key.
The title defaults to the selected population. You can edit the title.

3 In the X Axis Feature drop downmenu, select the feature that you want to graph
on the X Axis.

4 If you want to change the label for the X axis, edit the text in the X Axis Label
field.
The label defaults to the name of the selected feature.

5 If you are creating a scatter plot, select a feature and a label for the Y Axis.
6 Set the scaling for each axis of the graph. (The default is Auto, which allows the

application to automatically scale the graph.)
7 To set minimum andmaximum values for an axis, select Manual.
8 Select Linear or Log and enter Maximum andMinimum limits.
9 If you selected Log, enter the X > value.

Note: You can scale the X Axis of a graph or the Y Axis of a scatter plot in one of
twomodes: Linear or Log. The Linear mode is the default.
The Log mode allows you to logarithmically scale a section of the graph or
scatter plot. Selecting this mode causes the IDEAS application to perform bi-
exponential plotting. The > X value defines the linear portion of the graph as -X
through X. The application plots the values outside of these limits on a log-
arithmic scale. You can plot negative values as well as positive ones on a log-
arithmic scale by adjusting the limits.
Take care not to split a population such that it appears to be two separate pop-
ulations. This splitting is especially likely when negative values exist due to com-
pensation or corrections on the imagery. The graph on the left side was plotted on
a linear scale; the ones in the center and on the right side were plotted on log-
arithmic scales. The graph on the right side split the population because the
change from a linear to a logarithmic scale occurred in themiddle of the pop-
ulation. The IDEAS application automatically chose 1000 for the scale of the
graph that is in the center.
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10 Tomodify the display characteristics of each population or to change the layering
order, click Display Properties.
The Display Properties window opens.

11 Arrange the layering of the populations with the up and down arrows to allow
them to be displayed.

12 If you want to change the color or sybol of a population, click Populations... to
open the Population Manager. (For more information, see “Using the Population
Manager”.)

13 If you are creating a histogram overlay, you can customize it by performing the fol-
lowing steps:
• To fill or not fill the line for a population, select or clear the Fill checkbox.
• If you want, change the Bin count. (The default is determined by the X Axis

scale of the plots.)
• Decide whether to plot the Y Axis Units as a Frequency or a Normalized

frequency percentage.
14 Click OK in each window.

Tip: After you have created a graph, you can change its properties by right-click-
ing the graph and selecting Graph Properties. The samewindow that you used
to create the graph will reappear, and you can thenmake any changes that you
want.
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To show selected statistics for a graph

1 You can show and hide statistics by clicking the Statistics toolbar button in the
panel that contains the graph.

2 Or, right-click anywhere on the graph and click Statistics on the graph context
menu that appears.
The Statistics window appears.
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3 To display the statistics for the graph, select Show statistics. To close the Sta-
tistics Area for the graph, select Hide statistics.

4 Select the statistics that you want to display. The selected statistics will be dis-
played for each population on the graph. The statistics that are supported are the
Count, Percent Total, Percent Gated, Percent, Concentration (count/sample vol-
ume), Mean, Median, Standard Deviation, MAD (Median Average Deviation) RD
-Mean, RD -Median, CV, Minimum, Maximum, Geometiric Mean, Mode, var-
iance, and NaN (not a number).

5 When finished, click Close.

To show the legend for a graph

1 Right-click anywhere on the graph, and click Show/Hide Legend on the graph
context menu that appears.
If the legend was hidden, it appears on the graph. If the legend was shown, it dis-
appears from the display.
Note: The legend contains an entry for each population on the graph. If the graph
is a scatter plot, the legend shows the population and its associated point style
and color. If the graph is a histogram or overlay histogram, the legend shows the
population name, associated color, and line type.
• Tomove the legend, click and drag it. (You cannot drag the legend past the

boundary of the graph panel.)

Moving aGraph

• With any graph in the Analysis Area, you canmove it to another location by
clicking on the name of the graph and dragging it. Alternatively, select the
graph, right-click in the a blank space in the analysis area choose cut and then
right-click where you would like tomove the graph and choose past.
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Creating Regions on Graphs

Regions may be drawn on graphs to create new populations, based on the physical
location of objects on a graph, and to compute statistics. Tools for drawing regions
are found on the Analysis Area toolbar. A line regionmay be drawn only on a his-
togram. All other types of regions may be drawn only on a scatter plot.

A region can be copied to another graph in the same file or other open files. Regions
may also be copied from one instance of the IDEAS application to another.

When you draw a region on a histogram or scatter plot, you create a population of
objects defined by the region that may be viewed in the ImageGallery or on other
graphs.

To change the attributes of a region or delete a region and the populations dependent
on that region see “Using the RegionManager” .

To draw a region on a Scatter Plot

On the Analysis Area toolbar, click either the:

• Rectangle Region, or

• Oval Region, or

• Polygon Region button on the Analysis Area toolbar. Refer to “Creating
Regions onGraphs” for more details.

1 The Rectangle andOval tools work by clicking on the graph at the point where
you would like to start the region, and drag to the region endpoint.
The region grows as you drag.

2 Click again to complete the region.
If you are drawing a region on a histogram or scatter plot, the Create a Region
window appears.

3 Name the region.
4 Click the colored box to select an alternate color.
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5 Select Use for statistics only if you do not want to create a population from this
region.

6 Click OK.
The region appears on the graph with the name and color that you selected.

Polygon Tool Option

1 The Polygon tool works by clicking the scatter plot at the point where you would
like to start the polygon.

2 Click once for each vertex of the polygon.
3 Double-click to complete the drawing of the region.

A window appears that allows you to name the population created by the polygon
region and to assign the region’s display properties.

4 Click OK.
The region appears on the graph with the name and color that you selected.
Tip: Before you click OK, you can click Cancel or you can click the Pointer but-
ton on the Analysis Area toolbar if you decide not to create the region.

To Draw a region on a Histogram

1 On the Analysis Area toolbar, click the Line Region tool.

2 Drag the line across the histogram.

Tomove or resize a region on a graph

1 Click theMove/Resize Region toolbar button on the graph panel toolbar.

2 Click the region that you would like tomove or resize.
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When the region is selected, squares that can bemoved appear at the vertices
and the label.

3 The first time that you drag the region, the entire region and label move.
4 Dragging a specific vertex or label moves only that vertex or label.
5 To finishmoving or resizing the regions on the graph, click theMove/Resize

Region toolbar button again to deactivate the tool.

The populations and statistics are updated, and theMove/Resize Region toolbar
button is deactivated.
Note: The recalculation of statistics and populations may take amoment if the
data file is large or if many populations are dependent on the regions that are
beingmoved or resized.

To zoom in on the scale of a graph

1 Click the Scaling toolbar button on the graph panel toolbar.

2 Click and drag to define a rectangular region for rescaling.
The ZoomOut Scaling toolbar button appears in the graph panel toolbar, next to
the Scaling toolbar button.

3 Click the ZoomOut Scaling toolbar button to automatically scale the graph.
The ZoomOut Scaling toolbar button is removed from the graph panel toolbar.

To resize a graph

• Select the graph(s) to be resized and then click the sizing button tool small,

medium or large.
• A graphmay be resized by dragging the right, bottom or lower,right corner.

Tip: Select multiple graphs tomake them all the same size.

To copy and paste a region to another graph

1 Right-click anywhere on a graph, and click Copy Region to Clipboard on the
graph context menu that appears.
The Copy a Region to the Clipboard window appears.

2 Click the region to copy in the list, and click OK.
3 Right-click on the graph where you want to paste the region, and click Paste

Region from Clipboard on the graph context menu that appears.
4 If the region already exists (in other words, you are copying it within the same

instance of the application), the Create a Region window appears.
5 Rename the region and set the display properties for the resulting new pop-

ulation, and click OK.
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Note: When you copy a region, the scale is copied and is no longer associated
with the feature from which it was originally drawn. Therefore, the regionmight
not fit on the new graph.

To Apply or Remove a region on a graph

1 Right-click anywhere on the graph, and click Apply/Remove Region on the
graph context menu that appears. The Apply Graph Regions window appears.

2 Select the regions that you want to appear on the graph.
3 Clear the regions that you want to remove from the graph.
4 Click OK.

To show or hide a population on a scatter plot

1 Click Show/Hide Populations on the graph context menu.
The Show/Hide Populations window appears.

2 Select the populations that you want to appear on the graph.
3 Clear the populations that you want to remove from the graph.

4 Click OK.
Tip: On a scatter plot, youmay show or hide any population on the graph—regard-
less of the features on the axes. Each scatter plot has an original, or base,
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population. When you show a population on a scatter plot, only those objects that
are also in the base population will be shown. To aid in the identification of the
populations shown, change the characteristics of the population(s) in the pop-
ulationmanager.

Analyzing Individual Images

To analyze an image inmore detail, place the image in the Analysis Area to view
pixel positions and intensities as well as generate statistics for an area of the image.
You can also show theMeasurement tool for the image.

Image panels, which are shown in the following figure, each contain a toolbar in the
upper-right corner and a context menu that appears when you right-click an image.
An image in the Analysis Area is three times the size of an image in the ImageGal-
lery.

To add an image panel to the Analysis Area

• Right-click an image in the ImageGallery or Analysis Area, and click Add
Image to Analysis Areaon the context menu that appears.
The image panel appears in the Analysis Area.

To view the individual pixel intensities of a single channel image

• Move themouse pointer across the image.
The pixel positions and intensities appear under the image. (The pixel (0, 0) is
positioned at the upper left of the image.)

- 72 -



Chapter 4

To display theMeasurement tool in an image panel

• Right-click the image panel, and click Show Measurement Tool on the con-
text menu that appears.
The 10-micron bar appears.

To examine a line profile or the statistics for an area of an image

• Click and drag to create a boxed area on the image.
The Image Statistics are shown in the image panel. The statistics are cal-
culated for the area that is defined by the box. The line profile (the wavy line in
the image panel) represents the pixel intensity at each position along the red
line of the box.
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To change the display properties of an image

1 Click the Channel Display Properties button on the image panel toolbar.

The Display Properties window appears.

• For single channel image, you can change the displayedmask and adjust the
display intensity mapping. For more information, see “Setting the ImageGal-
lery Properties”.
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• For a composite image, you can change the images in the composite and
adjust the percent contribution of each image, see “Setting the ImageGallery
Properties”.
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2 Click OK.

To show or hide themask for a single channel image

• Click theMask button on the image panel toolbar, or right-click the image and
then click Show/Hide Mask on the image context menu.

Themask appears as a transparent cyan overlay on the image.

To turn the color on or off

• Click the Color button on the image panel toolbar, or right-click the image and
then click Color Off or Color On.

Viewing the Object Feature Values

TheObject Feature Values table, which is shown in the following figure, displays a
selected set of feature values for selected objects. For each feature, the name,
value, and description are shown.
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To view and customize the features shown in the Object Data table

1 Click the Object Feature Values tool.
2 Right-click anywhere in the table area to open themenu.

3 Choose Select Features.
The Select Object Features window appears.
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4 Select the features to view. Multiple features may be chosen by holding down the
Ctrl key.

5 Click OK.
The features appear in the Object Data table.

6 To add selected objects to the table right-click and choose Add Current Object.

To export or copy feature values

• Right-click in the table and choose Copy feature values to clipboard. For
more information, see “Creating Reports and Exporting Data”.

Adding Text to the Analysis Area

To add text to the Analysis Area

1 Click the Text button on the Analysis Area toolbar.

A text panel is added to the analysis area.
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2 Type a title and text.

Population Statistics

The Population Statistics table displays selected statistics for chosen populations.
The statistics that are supported are the Count, Percent Total, Percent Gated, Per-
cent, Concentration (count/sample volume), Mean, Median, Standard Deviation,
MAD (Median Average Deviation) RD -Mean, RD -Median, CV, Minimum, Max-
imum, Geometric Mean, Mode, variance, and NaN (not a number).

To view and customize the population statistics

1 Click the Populations Statistics tool.
2 Click the + next to the population to expand the list of populations.
3 Columns can bemoved by click-dragging.
4 Right-click in the column header in the table and themenu opens.

5 Edit Statistic Table opens a Statistics Properties window to enable changes to
multiple column statistics.

6 To add a single statistic column select Insert Column.
7 Select Edit Column tomake a change.
8 To delete a single column right-click on that column and select Delete Column.
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9 Select Delete All Columns to clear all statistics.
10 Order Columns places the columns in default order.
11 Copy Statistics copies the selected rows of the table in a text format that can be

pasted into other programs such as Excel.
12 Copy Statistics - Transposed copies the selected rows of the table and trans-

poses the data so that when pasted into other programs such as Excel the rows
become columns.

Overview of the Mask Manager
A mask defines a specific area of an image to use for feature-value calculations. The
IDEAS application contains aMask Manager for viewing existingmasks and cre-
ating new ones.This option is not available for basic FlowSight files without the
Quantitative Imaging (QI) upgrade.

When the IDEAS application loads a .rif file, the application creates a segmentation
mask for each channel image and stores themask along with the image in the .cif
file. Themasks, labeledM01 throughM12, contain pixels that are detected as
brighter than the background. In addition, the application generates a Combined
Mask, namedMC and a Not CombinedMask, Not MC for each object. A combined
mask consists of the union of themasks of all the channels of the object. A Not Com-
binedMask is all of the pixels with no intensities above background.

Youmight need to adjust themasks or create new ones that include only a specific
area of a cell, such as the nucleus. You can combinemasks by using Boolean logic,
or you can adjust them by applying functions.

Creating New Masks with the Mask Manager

There are two ways to work with new masks in theMask Manager. First, masks can
be created by using functions, which allows you to choose an input mask and, if
needed, adjust the channel and scalar input. Alternatively, masks can be created by
combiningmasks through Boolean logic. This option is not available for basic Flow-
Sight files without the Quantitative Imaging (QI) upgrade.

To create a new mask using Functions

1 Select Analysis > Masks.
TheMask Manager opens with a list of existingmasks on the left.

2 Click New.
The right side of the window is enabled to define a new mask.
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3 Click Function.
The DefineMask Function window appears with 15 available masks to use.
• Dilate: See “Dilate Mask”
• Erode: See “ErodeMask”
• Fill: See Fill Mask
• Inspire: See “Inspire Mask”
• Intensity: See“Intensity Mask”“Intensity Mask”
• Interface: See “InterfaceMask”
• Morphology: See “Morphology Mask”
• Object: See “Object Mask”
• Peak: See “Peak Mask”
• Range: See “RangeMask”
• Skeleton: See “SkeletonMask”
• Spot: See “Spot Mask”
• System: See “SystemMask”
• Threshold: See “ThresholdMask”
• Valley: See “Valley Mask”
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4 Select a function and choose the input mask(s), channel and scalar parameters
as needed. The right side of the window adjusts the display and view of the chan-
nel image.
• To view a different object in the file, select it in the Object list or type it's

number.
• To view a different image for the object, select it from the list.

5 The Link inputs checkbox is checked by default. Tomodify amask with different
inputs uncheck this box.

6 Click OK.
7 The new function is added to themask definition.
8 Click OK.

The new mask namewill appear in the list of Masks on the left side.
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To create a new combinedmask

1 Select Analysis > Masks.
2 Click New.
3 Use theMasks list on the left and the Definition toolbar to build a new mask

using the definitions of existingmasks with Boolean logic explained in the table
below.

Task Toolbar

Add amask to the
definition.

Double-click the feature in theMasks list.
Or, single click the feature in theMasks list and click the
leftmost down-arrow button on the toolbar.

Combine two
masks.

Use the Boolean AND or OR operator.
Use the AND operator to include only the pixels that
are in both of the original masks.
Use theOR operator to include the pixels that are in
either one of the original masks.

Select all pixels that
are not in the original
mask.

Use the Boolean NOT operator.
The NOT operator specifies whichmask will not be
used.

Affect the order of
operations.

Use the parentheses toolbar buttons.

Remove an item
from the end of the
definition.

Click the left-arrow button on the toolbar.

Table 1: Mask Tasks and Toolbar

4 Addmasks and Boolean logic to the definition as needed.
5 Click OK to add the definition to theMasks list.
6 Click Close.

Viewing and Editing a Mask

To view amask definition

1 Select Analysis > Masks.
TheMask Manager window appears.
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2 Click amask in theMasks list to view the definition in the Definition area.
3 Click Close.

To edit a mask function

1 In theMask Manager window, select themask that contains the function you
want to edit.

2 Click Edit.
3 Remove the definition for the combinedmask using the back arrow tool as

needed. Refer to “Creating New Masks with theMask Manager” for more infor-
mation on the definition tools.

4 Or click the Function button on the toolbar for a functionmask. The Define Mask
Function window appears. Refer to “Creating New Masks with theMask Man-
ager” for more information.

5 Click OK when finished.

Example of Creating a Mask

Here is an example of creating amask of the cytoplasm.

In this example, cells were stained with a green intracellular marker (in Channel 2)
and a red nuclear dye (in Channel 11). You can generate a cytoplasm-specific mask
by first refining the intracellular and nuclear masks and then removing the nuclear
mask pixels from the intracellular mask.
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1 Observe the default masks in the ImageGallery. Since the default masks are
designed to capture all the light in an image, they tend to include light that exists
beyond the perceived boundaries of the images. In this case, both the intra-
cellular and nuclear masks need to be refined. Start by creatingmorphology
masks for both channel images because theMorphology mask is designed to
conform to the shape of the image. Note that the Object mask functionmay also
be used in place of theMorphology mask function.

2 Select Analysis > Masks.
3 Click New.
4 Click on the Function toolbar button to adjust themask that will define the whole

cell. The Define Mask Function window appears.

5 Select Morphology in the Function list.
6 Select a startingMask.
7 Select Channel 2 (intracellular marker) on the left side of the window.
8 Click OK.
9 Click Set Default Name or, enter a new mask name.
10 Click OK to add this mask to the list.
11 Tomake theMorphology(Nuclear) mask, repeat steps 3–10 using Channel 11.
12 Click Close.
13 To view the resultingmorphology masks, open the Image Display Properties win-

dow and, if necessary, select the new mask(s) for the channel.

(Icon for Image Display Properties)
14 Next, you will subtract the nuclear morphology mask from the intracellular mask.

In theMask Manager window, click New.
15 Double-click theMorphology(Intracellular) mask in the list.
16 Click the AND button on the toolbar.
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17 Click the NOT button on the toolbar.

18 Double-click Morphology(Nuclear) mask in the list.
19 Enter a new mask name.
20 Click OK to add this mask to the list.
21 Click Close.
22 To view the resultingmask on a Channel 3 image, open the Image Display Prop-

erties window,and select the new mask for the channel in the view you are using.

Using the Feature Manager
This section describes how to create and delete features and to createmultiple fea-
tures by selecting categories. The only new feature options for FlowSight basic files
without QI are combined features. The following subsections cover this information:

Overview of the FeatureManager

Viewing feature definitions

Creating new features with the FeatureManager

Ranking features for best discriminating power

Overview of the Feature Manager

The IDEAS application defines a set of base features that you can use to create fea-
tures for each object. To do so, you use the object’s mask and/or its channel
images. After a feature has been created and its value calculated for all cells, you
can plot the feature values or view them as statistics for any population. For descrip-
tions of all the base features, see “Overview of the IDEAS® Features andMasks”.

When the IDEAS application opens a .cif or .rif file, the application calculates the
values of features as defined by the selected template. You can refine your template
so that it includes only those features of interest for your experiment.

You use the FeatureManager to examine existing features and to define new ones.
To gain access to the FeatureManager, select Analysis > Features or select it from
one of the context menus that are available in the histogram and scatter plot panels
with a right-click. While the FeatureManager is open, all calculations for creating
graphs and statistics are disabled. However, youmay view images and change the
population and channel views. When you close the FeatureManager, any changes
to feature names, definitions, and values are reflected in any currently displayed
graphs and statistics. The values of newly created features are also calculated at
this time.

You can create single features and combined features. You create a single feature
by selecting a base feature, such as Area or Intensity, along with amask and/or an
image. This option is not available for basic FlowSight files without the Quantitative
Imaging (QI) upgrade.You can create a combined feature by defining amathematical
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expression that includes one or more single features that exist in the feature list.
FlowSight files without the QI upgrade can utilize the combined feature option.

Some features, such as Area, depend on the boundary of a cell. These features
require you to select amask that defines the portion of the image to use for the cal-
culation. Other features, such as Max Pixel, depend on pixel intensity meas-
urements and require you to select an image. Other features require you to select a
mask and one or more images.

You can add and remove features from the feature list. The feature definitions are
stored in templates, so the definitions are available when you analyzemultiple data
files. The default template used for ImageStream data or QI FlowSight data includes
most of the base features for each channel image and channel mask that the feature
list contains. Certain features, such as Similarity and Spot, require extensive cal-
culations so the default template does not include them. The reason is to save time
when you load files. However, you can add these features to the feature list.

Viewing feature definitions

To view existing features

1 Click Analysis > Features or select Features from a graph panel context menu.
The Feature Manager window appears.

2 Choose an icon to sort the features:

Feature Icon Definition

Sorts features alphabetically.

Sorts features based on the images used.

Sorts features based on themasks used.

Sorts features by category, such as size, loca-
tion, shape, texture, signal strength, and system.

Sorts by base features, such as area, aspect

Table 1: Sorting Features
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Feature Icon Definition
ratio, intensity, and object number.

3 Click a feature in the Features list to view its definition in the right side of the win-
dow.

Delete this text and replace it with your own content.

Creating New Features with the Feature Manager

To create a new single feature

A single feature uses the definitions of a base feature along with amask and/or
an image.

1 Click New in the FeatureManager.
The right-hand area of the FeatureManager is enabled.

2 Select Single as the Feature Type.
TheMask and Image lists become visible depending on the single feature
selected.

3 Select themask and/or image that you want.
4 Enter a unique feature name or click Set Default Name.

The default name is the name of the base feature followed by the name of the
mask and name(s) of the image(s).

5 Click OK to add the new feature.
It appears in the Features list on the left side of the FeatureManager.

6 Click Close.
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Note: When you close the FeatureManager, the IDEAS application calculates
values for the new features. These calculations may take several minutes,
depending on the number and complexity of the new features and the size of the
image file.

To createmultiple features

A single feature uses the definitions of a base feature along with amask and/or
an image.

1 Click Add Multiple Features in the FeatureManager.
2 Sort the feature list alphabetically or categorically.
3 Select multiple base features andmasks
4 Select one image or check the box to create for all channels using default masks

and images.

5 Any list can be cleared by clicking the Clear Selected button.
6 When finished click Add Features to add the new features to the list.
7 Confirm the features in the next window.
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8 Delete any features you do not want to calculate.
9 Click OK when finished. The new features are added to the list in the featureman-

ager.
10 Close the Add Features window.
11 Close the FeatureManager. The new features are calculated when the feature

manager closes.

To create a new combined feature

A combined feature uses one or more single features created by amathematical
expression.

1 Click New in the FeatureManager.
The right hand area of the FeatureManager is enabled.

2 Select Combined as the Feature Type:
The editing interface appears.
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3 Enter the feature name in the Name box or use Set Default Name after you
have created your expression. The default name is the name of the definition
created.

4 Use the toolbar to build a definition (mathematical expression) of features and
operators:

Task Toolbar

Add a feature to
the definition.

Double-click the feature in the Features list.
Or, single click the feature in the Features list and select
click the leftmost down-arrow button on the toolbar.

Add an operator or
a parenthesis to
the definition.

Click the corresponding button on the toolbar.

Add a number to
the definition.

Enter the number in the box and then click the cor-
responding down-arrow button.

If the area is greyed-out, an operator must be selected first.

Add a function to
the definition.

Select the function in the list and then click the cor-
responding down-arrow button.

The available functions are ABS (absolute),
COS (cosine), SIN (sine), SQR (square), and
SQRT (square root).
If the area is greyed-out, an operator must be
selected first.

Remove an item
from the end of the
definition.

Click the left-arrow button on the toolbar.

Table 1: Combined Feature Tasks and Toolbar

5 Click OK.
6 Click Close.

Note: When you close the FeatureManager, the IDEAS application calculates
values for the new features. These calculations may take several minutes,
depending on the number and complexity of the new features and the size of the
image file.

To delete a feature

1 Select one or more features in the Features list by clicking them. To select more
than one feature, use the Ctrl key.

2 Click Delete.
A warningmessage will confirm or cancel deletion.
Note: Deleting a feature also deletes any populations that are dependent on that
feature. Your feature list may become large and unwieldy. You can narrow down
the list without deletions by sorting the list. See “Using the FeatureManager” for
more information.
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Ranking features by discriminating power

With the IDEAS application you are able to create an unlimited set of features by
using theMask manager to define location and the Featuremanager to choose a
mathematical expression that uses the image pixel data and/or themask. This can
make it difficult to choose a feature that provides good statistical separation of pop-
ulations of cells that have different appearances from each other. The following pro-
cedure describes the process to find features that separate two populations of cells
from each other with minimal knowledge of the feature set. A general description of
the steps is followed by a specific example.

General:

1 Set image display and draw preliminary regions to include cells of interest (i.e. sin-
gle, focused, positive cells).

2 Visually inspect overall quality of images and experiment to determine whether to
proceed or redo the experiment.

3 Create two tagged ‘truth’ populations of cells that represent the phenotypes you
wish to discriminate. Perform the discrimination on one characteristic difference
at a time.

4 Create any additional masks and features you think may help differentiate the
truth populations.

5 Calculate the statistical discrimination (RD) between the two populations
afforded by features in 1 category at a time. Pick the top feature for each cat-
egory.

6 Plot the features with the highest RD for the truth populations for each category
7 Validate by applying the feature to the base population, independent controls if

available and onmultiple files and experiments.

Example:

Treatment-induced actin polarization. The data file is available for practice. Log in to
your account on the Amnis website and look in the folder ‘Training data files’.

• Cells were incubated with inducing compound for 1 hour.
• The nucleus was probed with DAPI and actin stained with FITC.
• Large event image files were collected on the ImageStream.
• Compensation and analysis was done in IDEAS.

The following steps find the best features that distinguish changes in actin dis-
tribution.

1 Gate single, focused, actin-positive cells. View cells of interest.
2 Create the truth populations from within the cells of interest using the tagging

tool.
Note: If truth populations are in different files, merge them together before begin-
ning. When selecting truth populations, choose images that represent the full phe-
notypic range of each truth. In this example case, note that the ‘uniform actin’
truth population contains cells of varying shape and intensity that all have uniform
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actin distribution. Bias introduced during the selection of truth populations will
likely also bias the outcome during statistical ranking.
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The following figure shows the truth populations chosen to find a feature to dis-
criminate uniform versus polarized actin:

3 Create theMorphology and one or moreThreshold masks for the actin image.
4 Create features from the Size, Shape, and Texture categories using theMor-

phology, Threshold and Default actin channel masks.

a. Choose Features from the Analysis menu and click
AddMultiple Features.

b. In the Add Features window select Category as the

‘Sort Order’.
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c. Check Size, Shape and Texture base feature boxes.
d. Select the actin masks (Morphology, Object, Thresh-
old, M02)
e. Select the actin image (FITC).
f. Click Add Features to display the list of features to
add.
g.In the next window Click OK to add the fea-
tures.Features that already exist will not be recal-
culated.
h. Click OK and Click Close.
i. Close the FeatureManager by clicking Close and the
features will be calculated.

5 Add the feature statistics to the population statistics table. Do this one category
at a time. Multiple statistics tables can be added to the analysis area, one for
each category of features.

Once the features are calculated you can use the RD,(
Fischer's Discriminant Ratio) to a statistics table. The
RD measures the separation between 2 populations. In
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this case, the 2 truth populations picked in step 2. In
order to get the statistic for 1 category at a time, select
all of the features for the image and then deselect cat-
egories, to leave 1 category for the channel selected.

a. Click on to add a statistics table to the analysis
area.
b. Right-click in the table and choose Edit Statistics
Table.
c. Delete any statistics from the list.
d. Select the statistic ‘RD –Mean’.
e. Select one of the truth populations in the Reference
population box.

f. Sort by Images Used by clicking on the icon .
g. Check the box for the Ch02/Actin image.

h. Sort the features by Category .

i. De-select all but 1 category by checking and uncheck-
ing the box for the categories you want to de-select.
Note that the box next to the category will be checked
only if all of the features (all channels) in the category
are selected.
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j. Click ‘Add Statistics’.
k. Click Close.
l. Repeat until each statistics table contains 1 category
of features for Ch02(Actin).

6 Launch Excel and then Copy and Paste the statistics into the excel spreadsheet.

a. Select the row of statistics for the 2nd truth population
(the one not chosen above).
b. Right-click in the statistics table and choose Copy
Statistics - Transposed.
c. Paste into an Excel spreadsheet.
d. Keep all of the features and values selected and sort
the data set on the values column (headingmay be the
population name) largest to smallest. The feature with
the largest RD will be at the top.
Note: youmay have NaN values for some of the fea-
tures. This means Not a Number and occurs in some
cases when there is a division by 0. These can be
ignored.

7 Validate the features in IDEAS. Plot the features with the highest RD for the truth
populations and draw regions to discriminate.

8 Apply regions to the base population, independent controls if available and onmul-
tiple files and experiments.

9 Look for false negative and positive cells.
10 Repeat process if necessary by refining/creating new truth populations.

NOTES ON EVALUATING THE FEATURES:

Consider the features that produce the highest Rd. If there are any intensity based
features make sure that the staining was not uneven due to technical issues. If it is a
size feature, does it make sense with what you know about the cells and biology of
your experimental system? Since the feature value ranges vary between features
this is an approximate comparison and the result should be validated by viewing
images across the feature range from the whole population.

Using the Population Manager
A population is a group of objects. You create populations by drawing regions on
graphs, by hand-selecting (tagging) objects in the ImageGallery or on plots, or by
combining existing populations. After a population has been defined, you can view it
in the ImageGallery or on a plot and you can use it to calculate statistics.
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The PopulationManager provides a central place for maintaining the display prop-
erties of existing populations and for creating new combined populations.

To open the PopulationManager and view the population definitions

1 Select Analysis > Populations or right click a graph and select Populations.
The PopulationManager window appears.

Note: The list of populations is presented as a hierarchy that shows the depend-
encies of the populations on each other. The icon associated with a population
indicates how the population is defined.

icon Defined by

Tagging

Region
Combined

The definition of a selected population is shown in the Definition area.

To edit the display properties of a population

1 Within the Population Manager, click a population in the Populations list.
2 Change the name in the Name box.
3 Click a Color square to select a new color on the color palette and click OK.
4 Click a display symbol in the Symbol drop downmenu.
5 Click Close to save the population changes.
6 Click Revert to reject the changes.

To delete a population

1 Within the Population Manager, click a population in the Populations list.
2 Click Delete.

A confirmation warningmessage appears indicating all the dependent pop-
ulations that will also be deleted.

3 Click Yes to confirm.

To create a new combined population

1 Within the Population Manager (Analysis > Populations), click New.
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The right side of the PopulationManager window changes to allow you to define a
new population.

2 Enter a unique population name in the Name box.
3 Click a Color square to select a new color on the color palette and click OK.
4 Click a display symbol in the Symbol drop downmenu.
5 Use the toolbar to build the population definition as described in the table and

click OK when done:

Task Toolbar
Add a population to the def-
inition.

Select the population from the drop-downmenu.

Combine two populations.

Use the Boolean AND or OR operator.
Use the AND operator to include only the objects that
are in both of the original populations.
Use theOR operator to include the objects that are in
either one of the original populations.

Select objects that are not in
the original population.

Use the Boolean NOT operator.
The NOT operator specifies which population will not
be used. Note: youmust use AND before NOT.

Table 1: Population Tasks and Toolbar
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Task Toolbar

Affect the order of operations. Use the parentheses toolbar buttons.

Remove an item from the end
of the definition.

Click the left-arrow button on the toolbar.

See Creating Tagged Populations for information about tagged populations.

Creating Tagged Populations
You can hand-select objects from either the ImageGallery or a graph and group them
into a population.

To create a hand-selected population

1 Within the ImageGallery, click the TaggingMode toolbar button to begin.

The Tagged Population window appears.

2 Select either Update existing or Create New.
• To Create New, double-click images within the ImageGallery and select

Save. Create a new population name and display properties in the Create a
New Population window.

3 If you selected Update existing, choose a population to update in the drop down
menu.

4 In the Image viewing mode list, choose themode that you want from the drop
downmenu. See “Setting the ImageGallery Properties” for more information.

5 To add or remove an image from the tagged population, double-click either the
image in the ImageGallery or a dot in a bivariate plot.
The selected channel image for each tagged cell is displayed in the viewing area
of the Tagged Populations window. In the ImageGallery, a small smiley-face
icon appears on the left side of each tagged image. Each tagged object is also dis-
played as a yellow star in a graph in the Analysis Area.
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6 If you are updating an existing population, click the Update button in the Tagged
Populations window.

7 When you are finished, click Close in the Tagged Populations window.
Note: The taggingmode remains open until you click Close, and as long as the
ImageGallery is in taggingmode, you cannot create, resize, or move any regions
on the graphs.

Creating a tagged population from a file of object numbers

You can use a comma-separated text file of object numbers to create a tagged pop-
ulation.

Select Create Tagged Population from File under the Tools menu.

Browse for the file.

Name the population, select the color, symbol and click OK.

Using the Region Manager
The RegionManager provides a central place for defining the display properties,
names, and positions of existing regions. Regions can be deleted in the RegionMan-
ager tool.

Regions are drawn on graphs to create new populations, based on the physical loca-
tion of objects on a graph, and to compute statistics. Tools for drawing regions are
found on the Analysis Area toolbar. See “Creating Regions onGraphs” for more infor-
mation.

To open the RegionManager and view the region definitions
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1 Select Analysis > Regions or right click a graph and select Regions.
The RegionManager window appears. Click on the region in the list you want to
view.

To edit a region

1 Within the Region Manager, click a region in the Regions list.
2 Change the name in the Name box.
3 Click a Color square to select a new color on the color palette and click OK.
4 Change the X or Y position of the vertices in the Vertices box.
5 Select or de-select the Use for statistics only box.
6 Click Delete to delete a region.
7 Click Revert to reject the changes.
8 Click Close when finished.

Note: When a region is deleted, all populations that are defined by that region will be
deleted. A warning dialog box appears listing the populations that will be deleted.

Creating Reports and Exporting Data
The following six-page sample report was created by copying data
from IDEAS, the ImageStream Data Acquistion forms and excel into
a MS word document. This template can be found in the customer
documents in your training materials or in the knowledge-base of
your account on the Amnis website.
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The following subsections describe how you can print, copy or
export data directly from the IDEAS application. You may create
reports with Images, Graphs and Statistics in applications such as
those in Microsoft Office. If you are interested in analyzing data in
other analysis applications see the last section, Exporting data.

Reporting Images andGraphs

“Reporting Statistics”

Exporting data: Feature values, pixel intensities, TIF files, FCS files

Reporting Images and Graphs
The IDEAS application allows users to copy and print images and graphs, export sta-
tistics, feature data, pixel data, or TIF files for separate analyses.

Prepare the Image Gallery and Analysis Area for reporting.

1 Before you print or copy images, see “Setting the ImageGallery Properties” to
optimize the image display.

2 In addition to formatting the graphs and statistics in the Analysis area (seeOver-
view of the Analysis Area), the IDEAS application provides color mapping from
the dark mode that you see in the Analysis Area to a light mode that has a white
background for the printing and exporting of data. Because the population colors
might not show on a white background, you can change the colors when using
the light mode.

To use light background graphs in the Analysis Area

• Click the graph background tool to switch between light or dark mode.
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Tomap the dark mode colors to light mode colors

1 Select Options > Manage Color Schemes.
TheModify Reporting Color Schemewindow appears.

2 In the Select Dark Mode Color drop-downmenu, select the color that you want
to map.

3 To choose a different color, click the Select Light Mode Color Mapping color
square and click a new color on the color palette.

4 Click Update All Populations.
5 If you want to return the settings to the IDEAS defaults, click Reset to

Standard.
6 Click OK to save the changes or Cancel to exit.

Copy full or partial screens

To copy the entire screen to the Clipboard

• Press CTRL+PRINT SCREEN. It is then available for pasting into a third
party application.

To copy a window to the Clipboard

• Select the window and then press ALT+PRINT SCREEN. It is then available
for pasting into a third party application.

Print directly Analysis Area or Image Gallery

To print the Analysis Area data

• Select Reports > Print Analysis Area.
The IDEAS application prints all the graphs, statistics, text panels, and
images that are displayed in the Analysis Area.

To print the ImageGallery data

• Select Reports > Print Image Gallery.
The IDEAS application prints all the images that are visible in the ImageGal-
lery.

Copy Images

To copy the ImageGallery data to the Clipboard
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• Right-click anywhere in the ImageGallery and then click Copy Gallery to
Clipboard.
The IDEAS application copies all the images that are visible in the ImageGal-
lery to the Clipboard. The images can then be pasted into a third party report-
ing document.

To copy the object's images to the Clipboard

• Right-click an image in the ImageGallery and then click Copy Object
Images to Clipboard.

To copy a single image to the Clipboard

• Right-click an image in the ImageGallery or in the Analysis Area and then
click Copy Image to Clipboard.

Copy Graphs and Statistics

You can copy graphs and statistics, to other applications. Change the graph back-
ground, size, axis labels, region and population color or symbols as desired before
copying.

To copy a graph and/or statistics to the Clipboard
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1 Select light or dark mode graphs in the analysis area using the tool.

2 Right-click a graph and then click Copy Graph/Stats To Clipboard.
The Copy Graph window appears.

3 Select Graph, Statistics, Legend, Cursor and/or Show Sample Name and
Title depending on what you want to copy.

4 Adjust the Size scaling factor as desired. It is recommended to set this at 100%.
5 Click OKto copy the graph and/or the statistics to the Clipboard.

Note: The IDEAS application copies the statistics as ametafile. If you want to
export the data into a table, such as that in Microsoft Excel, youmust instead
click Export Statistics to Clipboard on the context menu.
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To export graph statistics to the Clipboard

• Right-click a graph and then click Export Statistics To Clipboard. They are
then available for pasting into a third party application.

To copy population statistics from a Statistics Table

• Right-click the table and then click Copy Statistics or Copy Statistics -
transposed. They are then available for pasting into a third party application.

Reporting Statistics

Define a Statistics Report

A statistics report definition can be saved in a .daf file or an .ast template file. It
allows users to select specific statistics within a .daf file and open the data in Excel.

A statistics report can be generated during batching if it is part of the template used.
It may also be applied to pre-existing .daf files from the Reportingmenu. In this
case, the rest of the template is not processed—only the report. The statistics report
definition allows you to specify population percentages and feature statistics and the
layout of the report is accessed from the reportingmenu.

To create a Statistics Report Definition

1 Select Reports > Define Statistics Report.

- 107 -



Getting Started with the IDEAS Application

The Statistics Report Definition appears.

2 Enter a Report title.
3 Under the Statistic Columns clickAdd Columns. The Add Statistic Report Col-

umnwindow opens.
4 Select the statistic(s) in the Statistics list.

• Count - the absolute count of the populations
• %Total - percentage of a population as a percentage of All
• %Gated - the percent of one population as a percentage of another, but not

used for tagged populations
• % - the percentage of one population as a percentage of another, also is used

for tagged populations
• Objects/mL - the concentration of the population in the sample run.
• CV - the coefficient variable
• Geometric Mean - standard statistical definition
• Maximum - standard statistical definition
• Mean - standard statistical definition
• Median - standard statistical definition
• MAD - standard statistical definition
• Minimum - standard statistical definition
• Mode - standard statistical definition
• RD - Median - the ratio discriminant (Fisher's discriminant) using theMedian

andMAD
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• RD - Mean - the ratio discriminant (Fisher's discriminant) using theMean and
StdDev

• Standard Deviation - standard statistical definition
• Variance - standard statistical definition
• NaN - stands for not a number; the number of objects whose values are not

valid numbers.

5 Select a population to base on the selected statistic(s).
6 Select a reference population if necessary. This is required for% and RD.
7 Select a Feature. This is not necessary for the%-related statistics, Count or

Objects/ml.
8 Click Add Statistics.The statistic is added to the list.
9 Click Close when finished.
10 Select a statistic in the list to view the definition or edit any input.
11 Change the name of the statistic by unchecking Use default title and typing a

new name if desired..
12 Delete Columns removes a selected statistic.
13 To reorder the list click-drag a statistic to it's new location.
14 Click Generate Report when complete to generate a report for a

current (opened) .daf file.
A prompt appears to save the text file. This text file can be opened from Excel.

15 If you do not want to generate a report, click OK to save your changes and exit
the window.

16 The saved template can generate a statistics report for multiple data files by
selecting Generate Statistics Report from the Reports menu or during batch proc-
essing.
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Generating a Statistics Report using .daf Files

Once a Statistics Definition has been created, the user can generate a statistics
report frommultiple .daf files. However, these files must use the same template.
Batch Processing can also generate a statistics report where statistics for each data
file will be generated either for .rif, .cif, or .daf files. Generating a statistics report
under the Reports menu simply adds the statistics template to the specified .daf
files.

ToGenerate a Statistics Report

1 Select Reports > Generate Statistics Report.
The current .daf file appears in the window with the specified statistics columns.

2 Pick a Report Definition. The definitionmay be obtained from a .daf or .ast file.
3 Change the Report title if desired.
4 Additional .daf files can be added or removed with the Add Files or Remove

Files buttons.
5 Reorder the files as desired by selecting files and then right-click the new loca-

tion in the list and choosemove here. You can Ctrl select multiple files in the
desired order and thenmove all at once by right-clicking in the desired location
and choosingmove here.

6 Click OK.
A prompt will confirm that the .daf file will be saved. The report title namewill be
used as the default file name for the report. In the above example, the file gen-
erated will be named “Report 1.txt”. If the report title contains illegal characters,
such as “\/><“ the default filenamewill change to “Statistics Report.txt”. Tab
delimited text format is used for the report.
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Reporting Statistics from a Single Graph or Statistics Table

Statistics can also be reported directly from an open .daf from the graph or statistics
tables in the analysis area.

To export graph statistics to the Clipboard

• Right-click a graph and then click Export Statistics To Clipboard. They are
then available for pasting into a third party application.

To copy population statistics from a Statistics Table

• Right-click the table and then click Copy Statistics or Copy Statistics -
transposed. They are then available for pasting into a third party application.

Exporting Data
You can export feature values for a population to the Clipboard, a text file, or a Flow
Cytometry Standard (FCS) file. You can export pixel intensity values for an object to
the Clipboard or a text file. Later, you can open or paste the FCS file into a spread-
sheet or other programs that uses the FCS file format. Keep inmind, however, that
limitations might exist on the number of values that these programs can import.

Exporting Feature Data

Exporting feature data is useful if you want to create an fcs file or graph the feature
data in a third party graphing application.

To export feature data

1 On the Tools menu, click Export Feature Values.
The Export Feature Data window appears.

2 Add files to the list on the left to export values for multiple files.
3 In the Select a population drop downmenu, select the population that you want.
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Getting Started with the IDEAS Application

If you haven’t defined any populations, All is the default. Tomake a new pop-
ulation, refer to “Creating Tagged Populations”.

4 In the Select feature values to export area, select features by clicking items in
the list or hold down the Ctrl while clicking to select multiple items.

5 Select the Export to option that you want. Note that data exported to the Clip-
board can be pasted directly into a spreadsheet program.

6 Select the Order by option that you want. Note that ordering by object causes
the values to be listed in a column, whereas ordering by feature causes the
values to be listed in a row.

7 Click OK.

Exporting Pixel Data

Exporting pixel data is useful when importing the data into third-party programs
where you would need to graph the individual pixels.

To export pixel data

1 On the Tools menu, click Export Image Pixel Values.
The Export Image Pixel Values window appears.

2 Select the object to export in the drop downmenu.
3 Select to Export to either the Clipboard or File.
4 Click OK.
5 Paste into desired application.

Creating TIFs From Population for Export
The IDEAS application allows users to create separate TIF files for channel images
for every event in that population. The exported TIF files can be opened in image
viewing applications that support 8 bit tif format for display or 16 bit tif format for anal-
ysis.

To create TIFs From Population for Export

1 On the Tools menu, click Export .tif Images.
The Create TIFs From Population window appears.
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2 Select the population and channels.
3 Type a prefix for the TIF file name.
4 Select the bit depth.
5 Select padded or raw.
6 Click OK.

A TIF file is created for every selected channel within the selected population.

Printing Data
The IDEAS application provides color mapping from the dark mode that you see in
the Analysis Area to a light mode that has a white background for the printing and
exporting of data. Because the population colors might not show on a white back-
ground, you can change the colors when using the light mode.

To use light background graphs in the Analysis Area

• Click the graph background tool to switch between light or dark mode.

To print the Analysis Area data

• Select Reports > Print Analysis Area.
The IDEAS application prints all the graphs, statistics, text panels, and
images that are displayed in the Analysis Area.

To print the ImageGallery data

• Select Reports > Print Image Gallery.
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Getting Started with the IDEAS Application

The IDEAS application prints all the images that are visible in the ImageGal-
lery.

Tomap the dark mode colors to light mode colors

1 Select Options > Manage Color Schemes.
TheModify Reporting Color Schemewindow appears.

2 In the Select Dark Mode Color drop-downmenu, select the color that you want
to map.

3 To choose a different color, click the Select Light Mode Color Mapping color
square and click a new color on the color palette.

4 Click Update All Populations.
5 If you want to return the settings to the IDEAS defaults, click Reset to

Standard.
6 Click OK to save the changes or Cancel to exit.
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To print an individual graph

1 Right-click the graph and then select Print Graph on the graph context menu.
The Print Graph window appears.

2 Select the checkboxes Graph, Statistics, Legend, Cursor, Show Sample
Name in Title to include the elements in the report.

3 If necessary, adjust the size scaling factor. Recomended setting is 100%.
4 Click OK to print the graph.
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Overview of the IDEAS Features and Masks
Objects passing through an Amnis cell analysis system are illuminated in different
directions by lasers and/or brightfield LEDs. Light emitted from the object is focused
through an objective lens and relayed to a spectral decomposition element, which
divides the light into six spectral bands located side-by-side across a charge-cou-
pled detector (CCD), as shown in the following diagram. Therefore, each object has
six images that can be individually analyzed or, because they are in spatial register
with respect to one another, reconstructed. Each of the separate bands is called a
channel. Below is an example of collecting 6 images. The ImageStreamx system
has a second camera option which enables collection of up to 12 images per object.
The FlowSight system has 12 channels collection on 1 camera.

About Features
The IDEAS application provides a large selection of criteria, or features, for analyz-
ing images. A feature is described by amathematical expression that contains quan-
titative and positional information about the image. A feature is applied to specific
locations of an image by the use of amask that identifies pixels within the region of
interest of the image. A few system features, such as Object Number, Camera Back-
ground and Flow Speed, do not require calculations, masks, or image intensity infor-
mation.

There is a slight difference in features created during data acquisition and those in
IDEAS. During acquisition features are created with the INSPIRE mask. Features
andmasks are calculated in IDEAS for files collected with the ImageStream or a
FlowSight with the Quantitative Imaging (QI) upgrade.

New masks and features can be created in files from an ImageStream or FlowSight
with the QI upgrade using theMask and FeatureManager tools. Features are
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created in IDEAS using base feature algorithms,such as Area or Intensity along with
amask and/or a channel image for files created with an ImageStream or with the
QI upgraded FlowSight machine. The default masks are recomputed in IDEAS for
ImageStream or QI enabled files. Combined features can be created using existing
features in mathematical expressions in the FeatureManager.

IDEAS groups the features into eight categories: size, location, shape, texture, sig-
nal strength, comparison, system and combined.

For more information, see Using theMask Manager and Using the FeatureManager.

To calculate the value of a feature, the IDEAS applicationmaps the channel image
to X and Y coordinates, as illustrated by the following diagram. Each box in the dia-
gram represents a pixel.

The pixel size and field of view per channel is dependent on themagnification used.
See your INSPIRE Users Manual for more information.
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Features Categories

Size

Size features are in microns and include Area, Diameter, Length, Major Axis, Minor
Axis, Major Axis Intensity, Mnor Axis Intensity, Perimeter, Thickness Max andMin,
Spot AreaMin, Width and Height.

Location

Location features include Angle, Angle Intensity, Centroid X, Centroid Y, Centroid X
Intensity, Centroid Y Intensity, Delta Centroid X, Delta Centroid Y, Delta Centroid
XY, Max Contour position, Spot DistanceMin, Valley X and Valley Y.

Shape

Shape features define themask shape and have units that vary with the feature.
They include the Aspect Ratio, Aspect Ratio Intensity, Compactness, Elon-
gatedness, Lobe Count, and Symmetry 2,3,4.

Texture

The Texture features determine local intensity variations in images and include
Bright Detail Intensity R3 and Bright Detail Intensity R7, Contrast, Gradient Max,
Gradient RMS, H Texture (H-Contrast, H-Correlation, H-Energy, H-Entropy, H-
Homogeneity, and H-Variance), Modulation, Spot Count, and Std Dev.

Contrast, Gradient Max andGradient RMS are generally used to determine best
focus.

Comparison

The Comparison features describe the difference of intensity measurements
betweenmasks or pixels in different images or the same image with different
masks. These include Bright Detail Similarity R3, Intensity Concentration Ratio,
Internalization, and Similarity.

System

The system features do not require amask.

Understanding the IDEAS® Features and Masks
This section contains the following subsections, which describe the
features that the IDEAS application uses for data analysis:

“Table of Base Features- by Category ”

“Table of Base Features- by Category ”

“Table of Base Features- by Category ”
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“Understanding the Location Features”

“Understanding the Shape Features”

“Understanding the Texture Features”

“Understanding the Signal Strength Features”

“Understanding the System Features”

“Understanding the Comparison Features”

“About Masks”

Mask Functions

Table of Base Features - Alphabetical

Delete this text and replace it with your own content.

Feature Name Category
“Angle Feature” Location
“Angle Feature” Location
“Area Feature” Size
“Aspect Ratio Feature” Shape
“Aspect Ratio Intensity Feature” Shape

“BkgdMean Feature”
Signal
Strength

“Bkgd StdDev Feature”
Signal
Strength

“Bright Detail Intensity R3 and Bright detail Intensity R7 Features”
Signal
Strength

“Bright Detail Similarity R3 Feature” Comparison
“Camera Line Number Feature” System
“Camera Timer Feature” System
“Centroid Features” Location
“Centroid Features” Location
“Circularity Feature” Shape
Compactness Feature Shape
“Contrast Feature” Texture
“Centroid Features” Location
“Centroid Features” Location
“Diameter Feature” Size
“Elongatedness Feature” Shape
“Elongatedness Feature” Texture
“Flow Speed Feature” System
“Gradient Max Feature” Texture
“Gradient RMS Feature” Texture
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Feature Name Category
“Height Feature” Size
“H Texture Features” Texture
“Intensity Concentration Ratio Feature” Comparison

“Intensity Feature”
Signal
Strength

“Internalization Feature” Comparison
“Length Feature” Size
“Lobe Count Feature” Shape
“Major Axis andMinor Axis Features” Size
“Major Axis Intensity andMinor Axis Intensity Features” Size
“Max Contour Position Feature” Location

“Max Pixel Feature”
Signal
Strength

“Mean Pixel Feature”
Signal
Strength

“Median Pixel Feature”
Signal
Strength

“Min Pixel Feature”
Signal
Strength

Minor Axis: see “Major Axis Intensity andMinor Axis Intensity Fea-
tures”

Size

“Modulation Feature” Texture
“Object Number Feature” System
“Objects/ml Feature” System
“Objects/sec Feature” System
“Perimeter Feature” Size
“Spot Intensity Min and Spot Intensity Max Features” Location

“Raw Intensity Feature”
Signal
Strength

“Raw Max Pixel Feature”
Signal
Strength

“Raw Mean Pixel Feature”
Signal
Strength

“Raw Min Pixel Feature”
Signal
Strength

“Raw Median Pixel Feature”
Signal
Strength

“Saturation Count Feature”
Signal
Strength

“Saturation Percent Features”
Signal
Strength

“Shape Ratio Feature” Shape
“Similarity Feature” Comparison
“Similarity Feature” Comparison
“Spot AreaMin Feature” Size
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Feature Name Category
“Spot Count Feature” Texture
“Spot DistanceMin Feature” Location

“Spot Intensity Min and Spot Intensity Max Features”
Signal
Strength

“Std Dev Feature” Texture
“Symmetry 2, 3, 4 Features” Texture
“Thickness Max Feature” Size
“Table of Base Features- by Category ” Size
“Time Feature” System
“Valley X and Valley Y Features” Location
“Width Feature” Size
“XCorr Feature” Comparison
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Table of Base Features- by Category

Feature
category Feature name In Default

Template?

In Expanded
Default Tem-
plate?

Mask_Image
Used in Default
Template

Size Size-based Features are in microns.
“Area Feature”
The size of themask in squaremicrons. Yes Yes M01-M12,MC

“Diameter Feature”
Estimates the diameter of themask based on Area. No Yes M01-M12

“Height Feature”
Based on a bounding rectangle, theWidth is the smaller side and
the Height is the longer side of the rectangle.

Yes Yes M01-M12

“Length Feature”
Measures the longest part of themask. Yes Yes M01-M12

“Major Axis andMinor Axis Features”
Describes the widest part of themask and the narrowest part of the
mask, respectively.

No Yes M01-M12

“Major Axis Intensity andMinor Axis Intensity Features”
Based on a bounding ellipse, theMinor Axis is the narrow part and
theMajor Axis is the widest part.

No Yes
M01_Ch01-
M12_Ch12

Minor Axis:“Major Axis andMinor Axis Features” No Yes M01-M12
“Perimeter Feature”
Describes circumference of themask. No Yes M01-M12

“Spot AreaMin Feature”
The Area of the smallest spot in themask. (See also “Spot Dis-
tanceMin Feature”, “Spot Intensity Min and Spot Intensity Max
Features” and “Spot Count Feature”.

No No

“Thickness Max Feature”
Describes the longest width of themask. No Yes M01-M12

Thickness Min Feature
Describes the shortest width of themask. No Yes M01-M12

“Width Feature”
Based on a bounding rectangle, theWidth is the smaller side and
the Height is the longer side of the rectangle.

Yes Yes M01-M12

Location
Location Features are in X,Y pixel coordinates from an origin
in the upper left corner, pixels or contour
“Angle Feature”
The angle of themajor axis from a horizontal plane in radians. No No

“Angle Feature”
The angle of themajor axis intensity from a horizontal plane in radi-
ans.

No No

“Centroid Features”
The central tendency of the pixels along the X Axis and Y Axis,
respectively.

No Yes M01-M12

“Centroid Features”
The central tendency of the pixels along the X Axis and Y Axis, No Yes

M01_Ch01-
M12_Ch12

Table 1: List of Features by category
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Feature
category Feature name In Default

Template?

In Expanded
Default Tem-
plate?

Mask_Image
Used in Default
Template

respectively, with the pixel intensities weighted.
“Centroid Features”
The distance between the X or Y Centroids of two images. No No

“Centroid Features”
The distance between the Centroids of two images. No No

“Max Contour Position Feature”
The location of the contour in the cell that has the highest intensity
concentration.

No No

“Spot DistanceMin Feature”
The shortest distance between two components (spots). See also
“Spot AreaMin Feature”, “Spot Intensity Min and Spot Intensity
Max Features” and “Spot Count Feature”.

Yes No

“Valley X and Valley Y Features”
The (X,Y) coordinates of theminimum intensity within the skeletal
lines that are used when creating the Valley Mask.

No No

Shape
Shape Features define the mask shape and have units that
vary with the feature.
“Aspect Ratio Feature”
The ratio of theMinor Axis divided by theMajor Axis. Yes Yes M01-M12

“Aspect Ratio Intensity Feature”
The ratio of theMinor Axis Intensity divided by theMajor Axis Inten-
sity.

Yes Yes
M01_Ch01-
M12_Ch12

“Circularity Feature”
The degree of themask’s deviation from a circle. No No

Compactness Feature
Describes the density of intensities within the object. No No

“Elongatedness Feature”
The ratio of the Height/Width which use the bounding box. No Yes M01-M12

“Lobe Count Feature”
The number of lobes in a cell. (Also see Symmetry) No No

“Shape Ratio Feature”
The ratio of Thickness Min/Length features. No Yes M01-M12

“Symmetry 2, 3, 4 Features”
These three features measure the tendency of the object to have a
single axis of elongation, a three-fold and a four-fold variation of the
shapes. See also “Lobe Count Feature”.

No No

Texture
Texture features measure pixel or regional variation and indi-
cate the granularity or complexity of the image.
“Bright Detail Intensity R3 and Bright detail Intensity R7 Features”
The Intensity of the pixels in the bright detail image using a 3 or 7
pixel structuring element. Also, see “Spot Mask” for a description
of the bright detail image.

Yes (R3)
No (R7) Yes

MC_Ch1-MC_
Ch6

“Contrast Feature”
Enumerates changes of pixel values in the image tomeasure the
focus quality of an image.

Yes Yes
M01_Ch01-
M12_Ch12

“Gradient Max Feature” No Yes M01_Ch01-
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Feature
category Feature name In Default

Template?

In Expanded
Default Tem-
plate?

Mask_Image
Used in Default
Template

Themaximum slope of the pixel value changes in the image to
measure focus quality of an image.

M12_Ch12

“Gradient RMS Feature”
Enumerates changes of pixel values in the image tomeasure the
focus quality of an image.

Yes Yes
M01_Ch01-
M12_Ch12

“H Texture Features”
Measures Haralick texture features. No Yes

M01_Ch01_5-
M12_Ch12_5

“Modulation Feature”
Measures the intensity range of an image, normalized between 0
and 1.

Yes Yes
M01_Ch01-
M12_Ch12

“Spot Count Feature”
Enumerates the number of spots.
See also “Spot DistanceMin Feature”, “Spot AreaMin Feature”,
and “Spot Intensity Min and Spot Intensity Max Features”.

No No

“Std Dev Feature”
Describes the overall distribution of pixel intensities. No Yes

M01_Ch01-
M12_Ch12

Signal
Strength

Signal Strength Features are measured in pixel values.

“BkgdMean Feature”
The average intensity of the camera background. Yes Yes Ch01-Ch12

“Bkgd StdDev Feature”
The standard deviation of the background intensities. No Yes Ch01-Ch12

“Intensity Feature”
The sum of the pixel intensities in themask, background sub-
tracted.

Yes Yes
MC_Ch01-
MC_Ch12

“Max Pixel Feature”
The largest pixel value within themask, background subtracted. Yes Yes

MC_Ch01-
MC_Ch12

“Mean Pixel Feature”
The average pixel value within themask, background subtracted. Yes Yes

M01_Ch01-
M12_Ch12

“Median Pixel Feature”
Themedian pixel value within themask, background subtracted. Yes Yes

M01_Ch01-
M12_Ch12

“Min Pixel Feature”
The smallest pixel value within themask, background subtracted. No No

“Raw Intensity Feature”
The sum of the pixel intensities within themask. No No

“Raw Max Pixel Feature”
The largest pixel intensity. Yes Yes

MC_Ch01-
MC_Ch12

“Raw Mean Pixel Feature”
The average pixel intensity: Raw does not have background sub-
tracted.

No No

“Raw Median Pixel Feature”
Themedian pixel intensity. No No

“Raw Min Pixel Feature”
The lowest pixel value within themask. Yes Yes

MC_Ch01-
MC_Ch12

“Saturation Count Feature”
The number of pixels in themask that are saturated. Yes Yes

M01_Ch01-
M12_Ch12
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Feature
category Feature name In Default

Template?

In Expanded
Default Tem-
plate?

Mask_Image
Used in Default
Template

“Saturation Percent Features”
The Percentage of pixels in themask that are saturated. Yes Yes

“Spot Intensity Min and Spot Intensity Max Features”
The raw intensity (not background subtracted) of the dimmest com-
ponent (spot).
See also “Spot Count Feature”, “Spot DistanceMin Feature”, and
“Spot AreaMin Feature”.

No No

Comparison
Difference of intensity measurements between masks or pix-
els.
“Bright Detail Similarity R3 Feature”
Measures the correlation of the bright details between image pairs. No No

“Intensity Concentration Ratio Feature”
Given twomasks, the ratio of the intensity in onemask to the total
intensity in bothmasks.

No No

“Internalization Feature”
The ratio of the intensity inside the cell to the intensity of the entire
cell.

No No

“Similarity Feature”
The Similarity is ameasure of the degree to which two images are
linearly correlated pixel by pixel within amasked region.

No No

“XCorr Feature”
The XCorr is ameasure of the degree to which two images frequen-
cies are cross correlated.

No No

System
System features do not require a mask and tend to deal with
system wide metrics.
“Camera Line Number Feature”
An incremental count of objects. No Yes

“Camera Timer Feature”
The clock rate in KHz. This is relative time. No Yes

“Flow Speed Feature”
The calculated flow speed inmm/sec. Yes Yes

“Object Number Feature”
The sequence of objects. Yes Yes

“Objects/ml Feature”
A local concentration of all objects per ml.
Note: to get objects per ml of a population, use the statistic ‘Con-
centration’.

No Yes

“Objects/sec Feature”
A local concentration of number of objects per second. Note: to get
objects per ml of a population, use the statistic ‘Concentration’

No Yes

“Time Feature”
The camera timer feature, converted to seconds. Yes Yes

Combined Any combined feature will be listed under Combined No No
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Table of Basic Features available without QI
The default masks used for FlowSight Basic (non-QI) files is the INSPIRE mask.

Feature Mask_Channel Brief definition
Area M01-GM, MC The size of the mask in square microns.

Aspect Ratio M01-M12 The ratio of the Minor Axis divided by
the Major Axis.

Bkgd Mean Ch01-Ch12 The average intensity of the camera
background.

Bkgd StdDev Ch01-Ch12 The standard deviation of the back-
ground intensities.

Camera Line
Number none An incremental count of objects.

Gradient RMS M01_Ch01-
M12_Ch12

Enumerates changes of pixel values in
the image to measure the focus quality
of an image.

Intensity MC_Ch01 - MC_
Ch12

The sum of the pixel intensities in the
mask, background subtracted.

Minor Axis M01-M12 Describes the narrowest part of the
mask.

Object Number none The sequence of objects.
Raw Centroid X

Raw Centroid Y
none

The central tendency of the pixels
along the X Axis and Y axis respec-
tively

Raw Max Pixel MC_Ch01- MC_
Ch12 The largest pixel value.

Raw Min Pixel MC_Ch01 - MC_
Ch12 The lowest pixel value.

Uncompensated
Intensity

MC_Ch01- MC_
Ch12

The sum of the pixel intensities in the
mask, background subtracted, no com-
pensation applied.

FlowSight Basic Features

Understanding the Size Features
Size features are in microns and include Area, Diameter, Length, Major Axis, Minor
Asix, Major Axis Intensity, Minor Axis Intensity, Perimeter, Thickness Max andMin,
Spot AreaMin, Width and Height.
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Area Feature
The number of microns squared in amask is equal to the Area. In the following fig-
ure, a 1 symbolizes whether the area is included in themask. The number of pixels
is converted to µm2. Note that 1 pixel = 0.25 µm2. As an example, a cell with a
mask that includes 2000 pixels is therefore equal to 500 µm2.

Application Examples:

— Quantify and compare cell size.
— Identify single cells.
— Calculate the radius, diameter and volume of the cell.
— Identify apoptosis using the Area of the 30% thresholdmask of a nuclear

dye.
— Create a pseudo FSC va. SSC plot for comparing with flow cytometry.

Diameter Feature
The Diameter feature provides the diameter of the circle that has the same area as
the object. The accuracy of the diameter is highly dependent on a close fittingmask
and roundness of the cell.

The images below depicts beads with a uniform diameter of 9microns.
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In the next figure, note that images with longer shapes that have the same area will
have the same diameter value.

Application Example:

— Used to obtain approximate size of the cell.

Height Feature
Using the bounding rectangle, Height is the number of microns of the longer side and
Width the shorter side. See also “Elongatedness Feature”.
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Application Example:

— These features can be used to separate rectangular shaped objects. For
curved objects, measurement is more accurately obtained using the thick-
ness features.

Length Feature
Lengthmeasures the longest part of an object. Unlike theMajor Axis feature, Length
canmeasure the object's length even if it folds to form a cashew, banana, or dough-
nut shape, where in many of these cases themajor or minor axis features would not
be able to differentiate these with true circular shaped objects with no hole.

This feature is based on an input mask and is sensitive to the variation of the input
mask shape. Selecting an input mask that can accurately capture the object shape
is important. See the “Shape Ratio Feature”, “Table of Base Features- by Category ”,
and “Thickness Max Feature” for more information.
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Major Axis and Minor Axis Features
TheMajor Axis is the longest dimension of an ellipse of best fit. TheMinor Axis is
the narrowest dimension of the ellipse of best fit. See the “Aspect Ratio Feature” for
more information.

Application Examples:

— Quantify and compare cell shape.
— Identify small, medium, and large cells.

Major Axis Intensity and Minor Axis Intensity Features
TheMajor Axis Intensity is the longest dimension of an ellipse of best fit and is inten-
sity weighted. TheMinor Axis Intensity is the narrowest dimension of the ellipse of
best fit and is intensity weighted.

The figure below illustrates the difference between intensity weighted and non-inten-
sity weightedMajor or Minor Axis and Aspect Ratio. See the “Aspect Ratio Intensity
Feature” for more information.
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Application Examples:

— Quantify and compare the image fluorescence shape.
— Identify single cells.

Perimeter Feature
The perimeter featuremeasures the boundary length of themask in the number of
microns.

This example uses a 1-pixel widemask created to illustrate how a perimeter would
appear.
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Application Examples:

— Quantify and compare cell circumference.
— Identify cells with highly irregular surfaces from smooth cells.
— Perimeter of themorphology or thresholdmasks can identify cells with or

without dendrites.

Spot Area Min Feature
The Spot AreaMin feature provides the area of the smallest spot (connected com-
ponent) in a spot or peak mask.

This is one of four features that can be used to identify objects with spots that are
close together, dim, bright or small when counting spots in an image. To use these
features, the spots need to be individually masked, such as using the Spot or Peak
Mask. The Spot AreaMin, Spot DistanceMin, and Spot Intensity Min or Max fea-
tures measure properties of different spots in an image and are often used with the
Spot Count feature (under Texture). For more information see “Spot DistanceMin
Feature”“Spot Count Feature”“Spot Intensity Min and Spot Intensity Max Features”.

• Spot AreaMin is the Area of spot 1
• Spot DistanceMin is distance 2 inmicrons
• Spot Intensity Max is the Raw Mean Pixel of spot 2
• Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example:

— In FISH Spot Counting, these features are used to identify objects with
ambiguous spots that are located too close together, are too dim to count
or are too small in order to remove these objects from the analysis.

Thickness Max Feature
Thickness Max measures the largest width of an object. This feature is based on an
input mask and therefore sensitive to the variation of the input mask shape.

- 132 -



Chapter 5

Selecting an input mask that can accurately capture the object shape is important.
See also “Table of Base Features- by Category ”, “Length Feature” and “Shape Ratio
Feature” for more information.

Thickness Min Feature
Thickness Minmeasures the smallest width of an object. This feature is based on an
input mask and therefore sensitive to the variation of the input mask shape. Select-
ing an input mask that can accurately capture the object shape is important. See
also “Thickness Max Feature”, “Length Feature” and “Shape Ratio Feature” for more
information.

Width Feature
Using the bounding rectangle, Width is the number of microns of the smaller side
and Height the longer side. See also “Elongatedness Feature”.
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Application Example:

— These features can be used to separate rectangular shaped objects. For
curved objects, measurement is more accurately obtained using the thick-
ness features.

Understanding the Location Features
Location features include Angle, Angle Intensity, Centroid X, Centroid Y, Centroid X
Intensity, Centroid Y Intensity, Delta Centroid X, Delta Centroid Y, Delta Centroid
XY, Max Contour position, Spot DistanceMin, Valley X and Valley Y.

Angle Feature
Angle is the angle of themajor axis from a horizontal plane in radians.

Application Example:

— Identify the orientation of an image relative to the image frame.

Angle Intensity Feature

Angle Intensity is the angle of themajor axis intensity from a horizontal plane in radi-
ans.
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Application Example:

— Identify the orientation of an image relative to the image frame.

Centroid Features

Centroid X and Centroid Y Features

Centroid X is the number of pixels in the horizontal axis from the upper, left corner of
the image to the center of themask. Centroid Y is the number of pixels in the vertical
axis from the upper, left corner of the image to the center of themask.

In this example, the Centroid X=54 and the Centroid Y=32.

Application Examples:

— Identify the center of themask.
— Calculate the Delta Centroid or the distance between two fluorescent

markers.
— Used by IDEAS to calculate the Delta Centroid X, Y, or XY.
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Centroid X Intensity and Centroid Y Intensity Features

Centroid X Intensity is the intensity weighted X centroid and is shifted from the
center of themask toward the center of fluorescence. The Centroid Y Intensity is the
intensity weighted Y centroid. X and Y pixel coordinates are calculated from an origin
in the upper left corner.

Application Examples:

— Identify the center of peak fluorescence.
— Calculate the distance between two fluorescent markers.
— Used by IDEAS to calculate the intensity weighted Delta Centroid X, Y or

XY.

Delta Centroid X and Delta Centroid Y Features

Both the Delta Centroid X and Y features measure the distance between the Cen-
troids X or Centroids Y, respectively, of two images using the user-providedmasks
for each image. Either one or both the centroids of the images may be intensity-
weighted. X and Y pixel coordinates are calculated from an origin in the upper left
corner to obtain the centroid positions and the distance between the centroids is con-
verted tomicrons.

An example is shown below.
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The graph below illustrates using the Delta Centroid X versus Delta Centroid Y to
identify cells with a variation of location of a protein with respect to the nucleus.

Cells with no spatial shift of signal between the nuclear stain(Ch6) and protein of
interest(Ch4) have a low Delta Centroid X and Y and are found in the lower left
corner. Cells with a large shift between the images in both the X and Y direction are
found in the upper, right section and those with a large shift in X but not Y are found
in the lower, right. Similarly a cell with a large shift in the Y direction and not X are
found in the upper, left. See “Centroid Features” to measure the X and Y shift
together.

Application Example:

— Used to identify capped versus not capped cells.
— Used tomeasure shifts in X or Y direction between two images.

Delta Centroid XY Feature

The Delta Centroid XY featuremeasures the distance between the Centroid feature
of two images using the user-providedmasks for each image. Either one or both the
centroids of the images may be intensity-weighted. X and Y pixel coordinates are cal-
culated from an origin in the upper left corner to obtain the centroid positions and the
distance between the centroids is converted tomicrons. In the example, below an
image pair is shown stained with the nuclear dye Draq 5 and a PE labeled antibody
that is differentially expressed two cells, either uniformly or in the pseudopod. The
two cells are identified by their different Delta Centroid XY values.
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Below is an example of using the Delta Centroid XY. A bivariate graph of a shape
ratio versus Delta Centroid XY can identify cells with caps as shown here:

Application Examples:

— Quantify the spatial relationship between two fluorescent probes.
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— Identify false apoptotic positive cells in the TUNEL and Annexin V
assays.

— Quantify shape change.
— Quantify capping of cell surface antigens.

Raw Centroid X and Raw Centroid Y Features

The centroid X and Y of the original position of the image during acquisition before it
was centered IDEAS. Data analyzed in IDEAS versions 4.0 or later cut and center
objects that were collected as one image in INSPIRE.

Max Contour Position Feature
TheMax Contour Position is defined as the location of the contour in the cell that has
the highest intensity concentration. It is invariant to object size and can accom-
modate localized intensity concentrations. The actual location in the object is
mapped to a number between 0 and 1, with 0 being the object center and 1 being the
object perimeter, which allows one to compare the results across cells of different
sizes. An example is shown below.

Application Example:

— Used in conjunction with the Internalization feature to determine the dis-
tribution of intensity within a cell.
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Shift X and Shift Y Features
The Shift X or Shift Y feature is the location of the highest cross-correlation of a pair
of images. When two identical images are aligned perfectly the cross-correlation is
at it's maximum. The shift X or Shift Y is the shift required to get the highest cross-
correlation value for the 2 images. This feature is usedmainly for troubleshooting
cross-camera alignment.

Spot Distance Min Feature
The Spot DistanceMin feature provides the shortest distance inmicrons between
two spots (connected components) in a spot or peak mask.

This is one of four features that can be used to identify objects with spots that are
close together, dim, bright or small when counting spots in an image. To use these
features, the spots need to be individually masked, such as using the Spot or Peak
Mask. The Spot Area, Distance, and Spopt Intensity Min or Max features measure
properties of different spots in an image and are often used with the Spot Count fea-
ture (under Texture). For more information see “Spot AreaMin Feature”; “Spot Count
Feature”; “Spot Intensity Min and Spot Intensity Max Features”.

• Spot AreaMin is the Area of spot 1
• Spot DistanceMin is distance 2 inmicrons
• Spot Intensity Max is the Raw Mean Pixel of spot 2
• Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example:

— In FISH Spot Counting, these features are used to identify ambiguous
spots that are located too close together, too dim, to bright or too small to
count and can be eliminated from the analysis.
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Valley X and Valley Y Features
The Valley X and Y are the exact X,Y coordinates of theminimum intensity within
the skeletal lines of the input mask. The objects condensed shape, typically 1-pixel
wide skeletal line is determined from the startingmask. This is also the origin of the
Valley mask. See “Valley Mask” and “SkeletonMask”.

In the figure below, the Valley X and Valley Y position of the 7AAD image is shown.
In this example a protein of interest in the PE image localizes to the synapse
between two cells.

These features define the origin of the Valley mask.
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Application Example:

— Measure the exact center of where a synapse between two cells is
located.

Understanding the Shape Features
Shape features define themask shape and have units that vary with the feature.
They include the Aspect Ratio, Aspect Ratio Intensity, Compactness, Elon-
gatedness, Lobe Count, and Symmetry 2,3,4.

Aspect Ratio Feature
Aspect Ratio is theMinor Axis divided by theMajor Axis and describes how round or
oblong an object is. See also: “Major Axis andMinor Axis Features”.
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See also “Elongatedness Feature” and “Shape Ratio Feature” for other shape ratios.

Application Examples:

— Quantify the roundness of themask.
— Identify single cells vs. doublets.
— Cell classification based on shape change.
— Identify recently divided cells in mitosis.

Aspect Ratio Intensity Feature
Aspect Ratio Intensity is theMinor Axis Intensity divided by theMajor Axis Inten-
sity. See also: “Major Axis Intensity andMinor Axis Intensity Features”.
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The figure below illustrates the difference between Aspect Ratio Intensity and
Aspect Ratio. See also: “Aspect Ratio Feature”.

Application Examples:

— Quantify the roundness of the fluorescent image.
— Better resolution for identifying single cells vs. doublets in experiments

using a DNA dye.
— Cell classification based on fluorescent morphology.

Circularity Feature
This featuremeasures the degree of themask’s deviation from a circle. Its meas-
urement is based on the average distance of the object boundary from its center
divided by the variation of this distance. Thus, the closer the object to a circle, the
smaller the variation and therefore the feature value will be high. Vice versa, the
more the shape deviates from a circle, the higher the variation and therefore the Cir-
cularity value will be low. See also “Compactness Feature”.

Below is an example using Circularity and Compactness to characterize the shape
of peripheral bloodmononuclear cells stained with the DNA dye Draq 5.
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Application Examples:

— Distinguish singlets and dou-
blets.

— Separate circular and non circular
shapes.

Compactness Feature
Compactness measures the

degree of how well the object is packed together. This feature is similar to the Cir-
cularity feature but unlike Circularity, this feature includes all of the pixels within the
mask and is intensity weighted. The higher the value, themore condensed the
object. See also “Circularity Feature”.

Below is an example using Circularity and Compactness to characterize the shape
of peripheral bloodmononuclear cells stained with the DNA dye Draq 5.
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Application Example:

— Differentiate between rounded objects with smooth boundary to less reg-
ular objects.

Elongatedness Feature
Elongatedness is the ratio of the Height overWidth of the object’s bounding box.
See also “Width Feature”.
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See also “Aspect Ratio Feature” and “Shape Ratio Feature” for other shape ratios.

Application Examples:

— Measure object shape properties to differentiate between long and narrow
versus short and thick objects.

— Quantify the roundness of themorphology mask.
— Identify single cells and doublets.
— Cell classification based on shape change.
— Identify recently divided cells in mitosis.

Lobe Count Feature
The Lobe Count feature counts the number of lobes in a cell. It is determined based
on themaxima of the weighted Symmetry features. The feature reports the values
1,2,3 or 4. If an object does not have a high value for Symmetry 2, Symmetry 3, or
Symmetry 4 it is reported as 1 for no lobes. An example is shown below. See also
“Symmetry 2, 3, 4 Features”.
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Application Example:

— Used in cell classification studies. Also used to differentiate small round
cells from small square cells of similar area.

Shape Ratio Feature
The Shape Ratio is Thickness Min divided by Length.

The Shape Ratio feature is based on an input mask and is sensitive to the variation
of the input mask shape. Selecting an input mask that can accurately capture the
object shape is important.
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See also “Aspect Ratio Feature” and “Elongatedness Feature” for other shape ratios.

Application Example:

— Measure object's elongatedness to provide shape classification.

Symmetry 2, 3, 4 Features
The Symmetry 2 featuremeasures the tendency of the object to have a single axis
of elongation and therefore 2 lobes. The Symmetry 3 featuremeasures the tendency
of the object to have a three-fold axis of symmetry and likewise, Symmetry 4 a four-
fold axis. The absolute value of these features are dependent on the number of
lobes. For example an image that has high 4 lobe symmetry will also have high 2
lobe symmetry. See the “Lobe Count Feature” for more information.
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Application Example:

— Classify different white blood cells based on themorphology of the nuclear
image.

Understanding the Texture Features
The Texture features determine local intensity variations in images and include
Bright Detail Intensity R3 and Bright Detail Intensity R7, Contrast, Gradient Max,
Gradient RMS, H Texture (H-Contrast, H-Correlation, H-Energy, H-Entropy, H-
Homogeneity, and H-Variance), Modulation, Spot Count, and Std Dev.

Contrast, Gradient Max andGradient RMS are generally used to determine best
focus.

Bright Detail Intensity R3 and Bright detail Intensity R7 Features
The Bright Detail Intensity R3 and Bright Detail Intensity R7 features compute the
intensity of localized bright spots within themasked area in the image. Bright Detail
Intensity R3 computes the intensity of bright spots that are 3 pixels in radius or less,
while Bright Detail Intensity R7 computes the intensity of bright spots in the image
that are 7 pixels in radius or less. In each case, the local background around the
spots is removed before the intensity computation.
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The figure below shows the process of obtaining the localized bright spots in the
image.

The graph below illustrates the use of the Bright Detail Intensity R3 feature on a
nuclear image to separate apoptotic cells from non-apoptotic cells.

Application Example:

— Identify cells that have bright specks such as Apoptotic cells.

Contrast Feature
The Contrast featuremeasures the sharpness quality of an image by detecting large
changes of pixel values in the image and is useful for the selection of focused
objects or apoptotic brightfield images. For every pixel, the slopes of the pixel
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intensities are computed using the 3x3 block around the pixel. This is similar to the
Gradient RMS calculation with different weighted assignments to the pixel arrays
with no background subtraction. Example images are shown in the figure below.

Application Examples:

— Find apoptotic images with high contrast in brightfield imagery.
— Determine overall focus quality of images.
— Use with Gradient RMS to determine focus quality.
— Characterize texture.

See also: “Gradient Max Feature” and “Gradient RMS Feature”.

Ensquared Energy Feature
The Ensquared Energy feature is ameasure of image quality. Computes the inten-
sity of the square block around the brightest pixel using the diameter input as the
side for the square divided by the intensity of the total intensity. The closer this ratio
is to 1.0 the better focused the image. This feature is mainly used for single, uniform
particles such as beads.

The figure below shows the image quality test using the Ensquared Energy feature.

Gradient Max Feature
TheGradient Max featuremeasures the sharpness quality of an image by detecting
largest change of pixel values in the image and is useful for the selection of focused
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objects.

This figure shows the change in intensity across the red line. The top image has a
larger slope change than the lower image.

Application Example:

— Determine peak focus quality of images.
— Also used to characterize texture. However, the Gradient RMS and Con-

trast feature aremore robust for these applications.

See also: “Gradient RMS Feature” and “Contrast Feature”.

Gradient RMS Feature
TheGradient RMS featuremeasures the sharpness quality of an image by detecting
large changes of pixel values in the image and is useful for the selection of focused
objects. TheGradient RMS feature is computed using the average gradient of a pixel
normalized for variations in intensity levels. This is similar to the Contrast cal-
culation with different weighted assignments to the pixel arrays and with background
subtracted. Example images are shown in the figure below.
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Application Examples:

— Determine overall focus quality of images.
— Used with Contrast to determine focus quality.
— Characterize texture.

See also: “Gradient Max Feature” and “Contrast Feature”.

H Texture Features
H Texture features include the following: H Energy Mean and Std, H Entropy Mean
and Std, H Contrast Mean and Std, H Homogeneity Mean and Std, H Correlation
Mean and Std, H VarianceMean and Std Features.

R.M. Haralick (H) defined a set of texture features that characterize the spatial rela-
tionships amongst the pixel values in an image1. IDEAS uses a common nor-
malizationmethod so that images with different intensities can be directly
compared. For each H texture feature, themean reflects the average value and the
standard deviation (Std) reflects the presence of texture orientation.

The user defines the texture grain by assigning a granularity value. For very fine tex-
tures, this value is small (1-3 pixels), while for very coarse textures, it is large (>10).
In the IDEAS default template, the granularity value is 5.

While these features have value for distinguishing cellular texture when used individ-
ually, images often contain amixture of different textures at different grains. There-
fore, these features aremost powerful when combined.

Application Example:

— Quantify texture in cells.
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1Haralick, R.M., K. Shanmugan, and I. Dinstein, "Textural Features for Image Clas-
sification", IEEE Transactions on Systems, Man, and Cybernetics, Vol. SMC-3,
1973, pp. 610-621.

Modulation Feature
TheModulation featuremeasures the intensity range of an image, normalized
between 0 and 1.

The formula is: Modulation = Max Pixel - Min Pixel / Max Pixel + Min Pixel

The following example illustrates Modulation on brightfield images and Intensity of
scatter in channel 1.

HighModulation

Low Modulation

Low Modulation

Application Example:

— Quantify image quality and characterize contrast and texture in cells.
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Spot Count Feature
The Spot Count feature provides the number of connected components in an image.
The connected component algorithm examines the connectivity of each pixel based
on whether this pixel is connected to a particular spot or the background. In order to
count the number of connected components themask input is very important. See
“Spot Mask”, “Peak Mask”, and “RangeMask” for information onmasking spots.
See also “Spot AreaMin Feature”, “Spot DistanceMin Feature”, and“Spot Intensity
Min and Spot Intensity Max Features” for more information.

The following figure illustrates the application of Spot Counting to quantify parasitic
infection of Babesia in erythrocytes by staining nuclei with YOYO (green).

Application Examples:

— Counting parasites.
— Counting phagocytosed particles.
— FISH spot counting.
— Counting punctate spots in images.

Std Dev Feature
The Std Dev feature describes the overall distribution of pixel intensities.
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The Std Dev is the standard deviation of the pixel intensity values in themask. The
Std Dev value provides an indication of the texture or complexity of an object.

The following illustrates that apoptotic cells (AnxnV positive) exhibit higher Std Dev
values in the darkfield channel (scatter) and higher brightfield Modulation values than
non-apoptotic cells (AnxnV negative).

Application Example:

— Quantify intensity variation within amask.
— Distinguish apoptotic and necrotic cells.

Understanding the Signal Strength Features
Signal Strength features include the following:

• BkgdMean and Bkgd StdDev features describe the background of the image.
• Intensity and Raw Intensity features quantify the intensities in the region of

interest.
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• Raw Max, Raw Min, Raw Mean and Raw Median Pixel report single pixel
values in an image.

• Max, Min, Mean andMedian Pixel report background subtracted single pixel
values in an image.

• Saturation Count and Saturation Percent quantify the saturated pixels.
• Spot Intensity Min is used when counting spots.

Note that when the name includes ‘Raw’, this means that there is no background
subtraction.

Bkgd Mean Feature
The BkgdMean feature estimates the average camera background level in an image
by taking themean of the background pixels.

Application Examples:

— Obtain estimate of themean camera background level.
— Compute background-subtracted pixel values in other feature com-

putations.

Bkgd StdDev Feature
The Bkgd Std Dev feature estimates the standard deviation of the camera back-
ground level in an image computed using the background pixels.

Application Example:

— Obtain estimate of the camera background noise.

Intensity Feature
The Intensity feature is the sum of the background subtracted pixel values within the
masked area of the image.
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Application Examples:

— Quantify relative levels of fluorescence between cells and within different
regions of the same cell.

— Immunophenotyping.
— Cell cycle analysis.
— Protein expression.
— Protein activation.

Max Pixel Feature
TheMax Pixel feature is the largest value of the background-subtracted pixels con-
tained in the input mask. An example plot is shown below that demonstrates the
advantage of using this feature over the Intensity feature for identifying true positive
events. For a concentrated signal, Max Pixel is more sensitive than Intensity as
shown in the figure below.

The relationship of Max, Mean, Median, andMin Pixel is shown in the figure below:
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Application Examples:

— Used to estimate the true peak fluorescence activity. Is preferred over the
Raw Max Pixel for this application.

— Max Pixel to Mean Pixel ratio identifies bright punctate staining vs. uni-
form staining.

Mean Pixel Feature
TheMean Pixel feature is themean of the background-subtracted pixels contained in
the input mask. This is computed as Intensity/number of pixels.

The relationship of Max, Mean, Median andMin Pixel is shown in the figure below:
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Application Examples:

— Estimate the average fluorescence activity. This feature is preferred over
the Raw Mean Pixel feature.

— Quantify relative levels of mean fluorescence between cells.
— Identify bright punctate spots by calculating themax tomean pixel ratio.
— Track internalization of surface bound antibodies.

Median Pixel Feature
TheMedian Pixel feature is themedian of the background-subtracted pixels con-
tained in the input mask. It is more robust than themean as an estimate of the aver-
age fluorescence since it is less influenced by outliers.

The relationship of Max, Mean, Median andMin Pixel is shown in the figure below:
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Application Example:

— Estimate the average fluorescence activity. This feature is preferred over
the Raw Median Pixel feature.

Min Pixel Feature
TheMin Pixel feature is the smallest value of the background-subtracted pixels con-
tained in the input mask. There will be some negative numbers due to the back-
ground subtraction, therefore the Raw Min Pixel feature is preferred.
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Application Examples:

— Obtain theminimum value in an image after background subtraction. Very
likely to be negative in brightfield imagery.

— Quantify spectral absorbance using the brightfield image.
— Identify over compensated images.

Raw Intensity Feature
The Raw Intensity feature is the sum of the pixel values within themask including
camera background.

Application Example:

— Estimate raw fluorescence activity. This feature is less relevant than the
Intensity feature because it includes camera background intensity.

Raw Max Pixel Feature
The Raw Max Pixel feature is the largest value of the pixels contained in the input
mask.
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Application Examples:

— Determine the presence of saturated events.
— May also be used to estimate the peak fluorescence activity, though the

Max Pixel feature is recommended for this application.
— Measure themaximum pixel value within themask.
— Identify cells that saturate the CCD, Saturation Count feature can also be

used for this application.

Raw Mean Pixel Feature
The Raw Mean Pixel feature is themean of the pixels contained in the input mask.
This is computed as Raw Intensity/number of pixels.

Application Example:

— Estimate the raw average fluorescence activity. This feature is less rel-
evant that theMean Pixel feature.
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Raw Median Pixel Feature
The Raw Median Pixel feature is themedian of the pixels contained in the input
mask.

Application Example:

— Estimate the raw average fluorescence activity that is robust to outliers.
This feature is less relevant than theMedian Pixel feature.

Raw Min Pixel Feature
The Raw Min Pixel feature is the smallest value of the pixels contained in the input
mask. The example below illustrates quantifying the level of malarial infected cells
by usingMin Pixel values of brightfield imagery.

Application Example:

— Quantify spectral absorbance using the brightfield image.
— Identify over compensated images.
— Measure the level of malaria infection in RBCs.
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Saturation Count Feature
The Saturation Count feature reports the number of saturated pixels in an object.
See also “Saturation Percent Features”.

In the figure below, objects with saturated pixels are lined up at the Raw Max Pixel
value of 1023 and a selected image is shownwith saturated pixels in red.

Application Example:

— Measure the validity of the experiment setup. Saturated datamay not
produce useful information.

Saturation Percent Features
The Saturation Percent feature reports the percentage of saturated pixels in an
image. Pixel intensities aremeasured on the camera pixels from 0 to 1023 (10 bit)
and therefore become saturated and cannot be quantified after 1023. See also “Sat-
uration Count Feature”.

An object with saturated pixels shown in red:
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Application Example:

— Measure the validity of the experiment setup. Saturated datamay not
produce useful information.

Spot Intensity Min and Spot Intensity Max Features
Spot Intensity Min provides the smallest Raw Mean Pixel value (not background sub-
tracted) of the dimmest spot (connected component). The Raw Mean Pixel values
for each spot is computed and the smallest value is reported.

Spot Intensity Max provides the largest Raw Mean Pixel value (not background sub-
tracted) of the brightest spot (connected component). The Raw Mean Pixel values
for each spot is computed and the largest value is reported.

These are two of four features that can be used to identify objects with spots that are
close together, dim, bright or small when counting spots in an image. To use these
features, the spots need to be individually masked, such as using the Spot or Peak
Mask. The Spot Area, Distance, and Intensity Min or Max features measure prop-
erties of different spots in an image and are often used with the Spot Count feature
(under Texture). Spot AreaMin (Size) provides the area of the smallest spot. Spot
DistanceMin (Location) provides the shortest distance between two spots. See also
“Spot AreaMin Feature”, “Spot DistanceMin Feature”, and “Spot Count Feature”.

The following diagram illustrates these features:

• Spot AreaMin is the Area of spot 1
• Spot DistanceMin is distance 2 inmicrons
• Spot Intensity Max is the Raw Mean Pixel value of spot 2
• Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example:
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— In FISH Spot Counting, these features are used to identify ambiguous
spots that are located too close together, too dim, to bright or too small to
count and can be eliminated from the analysis.

Bright Detail Similarity R3 Feature
The Bright Detail Similarity R3 feature is designed to specifically to compare the
small bright image detail of two images and can be used to quantify the co-local-
ization of two probes in a defined region, such as that of endosomes. The Bright
Detail Similarity R3 feature is the log transformed Pearson’s correlation coefficient
of the localized bright spots with a radius of 3 pixels or less within themasked area
in the two input images. Since the bright spots in the two images are either cor-
related (in the same spatial location) or uncorrelated (in different spatial locations),
the correlation coefficient varies between 0 (uncorrelated) and 1 (perfect correlation),
and does not assume negative values. The coefficient is log transformed to increase
the dynamic range between {0, inf}.

The following figure shows the Bright Detail Similarity R3 graph of two populations,
one that has colocalization and one that has no colocalization.

The figure below illustrates the process of obtaining the localized bright spots. The
bright areas are eroded from the original image and the detail eroded image is sub-
tracted from the original image resulting in the bright detail image.
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The figure below shows the correlation analysis between an image pair.

Application Examples:

— Quantify the degree of colocalization between two probes.
— Track internalization and intracellular trafficking of antibody drug con-

jugates to either the endosomes or the lysosomes.
— Colocalization of Rituxan and compliment C3b.

Intensity Concentration Ratio Feature
The intensity concentration ratio is defined as the ratio of the intensity inside the first
input mask to the intensity of the union of the twomasks - the higher the score, the
greater the concentration of intensity inside the first mask. All pixels are background-
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subtracted. The ratio is invariant to cell size and can accommodate concentrated
bright regions and small dim spots. The ratio is mapped to a log scale to increase the
dynamic range to values between {-inf, inf}. This feature is a generalization of the
Internalization feature. See “Internalization Feature” for more information.

Application Example:

— Quantify relative intensity concentrations between different cellular com-
partments. Internalization is a special case of this where the first mask is
the internal compartment and the second is themembrane region.

Uncompensated Intensity
The Uncompensated Intensity feature is the sum of the background subtracted pixel
values within themasked area of the image with no compensation applied. This is
the Intensity of the uncompensated image. This feature is calculated in INSPIRE
during acquisition.

Understanding the Comparison Features
The Comparison features describe the difference of intensity measurements
betweenmasks or pixels in different images or the same image with different
masks. These include Bright Detail Similarity R3, Intensity Concentration Ratio,
Internalization, and Similarity.

Internalization Feature
The Internalization feature is defined as the ratio of the intensity inside the cell to the
intensity of the entire cell. The higher the score, the greater the concentration of inten-
sity inside the cell. All pixels are background-subtracted. The user must create a
mask to define the inside of the cell for this feature (see “About Masks” and “Over-
view of theMask Manager”). The feature is invariant to cell size and can accom-
modate concentrated bright regions and small dim spots. The ratio is mapped to a
log scale to increase the dynamic range to values between {-inf, inf}. Internalized
cells typically have positive scores while cells with little internalization have neg-
ative scores. Cells with scores around 0 have amix of internalization andmembrane
intensity.

Composite Images of brightfield and channel 6 are shown for High, Medium, and
Low Internalization values.
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Application Examples:

— Quantify internalization when supplied with the internal mask.
— Quantify the intensity ratio of a region of interest to the whole cell.

Similarity Feature
The Similarity feature is the log transformed Pearson’s Correlation Coefficient and is
ameasure of the degree to which two images are linearly correlated within amasked
region.

The following figure shows two image pairs that are in spatial registry to one another.
On the left the NF-kB (green) is predominantly located in the cytoplasm of the cell
and has a dissimilar distribution compared to the 7-AAD image (red). When the inten-
sity of the green is high, the intensity of the red is low and vice versa. The Similarity
value for this cell is -2.067 indicating that the image pair has a high degree of dis-
similarity. Analysis of the image pair on the right shows that when the intensity of the
green is high, the intensity of the red is high and the Similarity value is a high positive
number.
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Below are examples of cells with varying amounts of similarity between the NFkB
image in green and 7-AAD image in red shown here as a composite image. Themost
dissimilar image pairs in the upper left to themost similar image pairs in the upper
right.

Application Examples:

— Quantify translocation.
— Identify copolarization of two probes.

XCorr Feature
The XCorr feature is ameasure of similarity or 'sameness' between two images - the
higher the value, themore similar the images. It is robust to intensity variations and
relative shifts between the images and is typically used with the combinedmask
MC. It is computed using the normalized cross correlation between the two input
images.

Application Examples:

— Used as amask-independent measure of similarity between two images.

Understanding the System Features
The system features do not require amask.

Camera Line Number Feature
The Camera Line Number feature returns the camera line number values. This fea-
ture is obtained from INSPIRE.

Application Example:
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— Used in objects per mL feature.

Camera Timer Feature
The Camera Timer feature returns the camera timer values that are in ticks. This fea-
ture is obtained from INSPIRE.

Application Example:

— Used in Time feature.

Flow Speed Feature
The Flow Speed is the calculated flow speed, in mm/sec, of the object.

The Flow Speed feature is the speed of flow of the cells. It is obtained from
INSPIRE. It should be very consistent across all cells in a file.

Application Example:

— Determine consistency of flow.

Object Number Feature
TheObject Number feature denotes the serial number of a cell in a file.

Application Example:

— Reference an object in a file.

Objects/ml Feature
TheObjects per mL feature returns the object concentration with respect to local vol-
ume.

Application Example:

— Monitor the object flow during the run. Note: Use the statistic Con-
centration to obtain objects/ml of a population.

Objects/sec Feature
TheObjects per sec feature returns the local object concentration with respect to
time.

Application Example:

— Monitor the throughput during a run. Note: Use the statistic Concentration
to obtain objects/ml of a population.

Time Feature
The Time feature returns the camera timer values that are in ticks, converted to secs
with a formula.
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Application Example:

— Obtain the time taken to collect a sample

About Masks
The set of pixels that contains the region of interest is called themask. In the fol-
lowing picture, themask consists of the set of pixels on the right image that are col-
ored cyan. The cell is represented in the greyscale image on the left. Calculating
some feature values, such as the Area value, requires only amask. Calculating
others, such as Intensity value, requires amask and a channel image.

There are three types of masks: Default masks, CombinedMasks and Function
Masks:

1 Default masks namedM01 throughM12 are either created in INSPIRE during
acquisition or created in IDEAS when a .rif file is opened. The default mask used
by INSPIRE during acquisition (Inspire) is different than the default mask created
in IDEAS (Default Object) when a .rif file is opened with QI or from an ImageS-
treamX. Thesemasks are stored in the .cif file and cannot be changed by the
user.
Conversion note: Versions of IDEAS prior to 3.0 were using the System function
mask with a weight of 5 for the default masks which was more permissive and
resulted in larger masks.
Below is an example of the difference between the default masks.

2 Combinedmasks are created using Boolean logic to combine and subtract
masks. For example, the cytoplasmic mask is created by taking the brightfield
mask and not themorphology mask of the nuclear image.
You can use theMask Manager to combinemasks of different regions or images.
The IDEAS application default template provides a combinedmask namedMC
that is the union of the pixels from all channel masks and a NMC mask that is
everything outside of MC. The following illustration shows two channel masks
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that are combined into onemask, which is shown in the right-most panel.

Below is an example of making amembranemask using Boolean Logic.

3 Functionmasks are created with user input. There are fourteen types of function
masks, Dilate; Erode; Fill; Inspire; Intensity; Interface; Morphology; Threshold;
Spot; System; Object; Peak; Range; Skeleton; and Valley. Each of the functions
masks are defined here.

Refer to “Using theMask Manager” for more details about how to create new masks.

Dilate Mask
The Dilate mask adds the selected number of pixels to all edges of the starting
mask.

Erode Mask
The Erodemask removes the selected number of pixels from all edges of the start-
ingmask.
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Fill Mask
The Fill mask fills in any holes in the startingmask.

Inspire Mask
The Inspire mask masks pixels above background and is themask used during data
acquisition in INSPIRE. This mask is available to understand what is beingmasked
during collection and is not generally used for feature calculations.

Note: this mask is new in IDEAS versions 4.0 or later.

Intensity Mask
The Intensity mask masks pixels between the lower and upper raw intensity thresh-
olds not background subtracted. See also “ThresholdMask”.

In the example below, cell #10678 is bright and cell #11992 is dim. The 50% Thresh-
old mask is similar for both images whereas the Intensity mask 250+ is quite dif-
ferent, since only a few pixels in the dim image are greater than 250 counts, while
most of themetaphase plates in the bright image aremasked.
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Interface Mask
The interfacemask identifies pixels in an object where the object is in contact with a
second object. Three input parameters are defined. First, themask of one of the
objects (cell of interest). Next, themask that covers both objects (conjugate). A
close fittingmask using another functionmask such as Object (tight) can be used for
the cell of interest mask. A brightfield mask can be used for the conjugate. Finally,
the width of the interfacemask from the contact point towards the cell of interest is
entered.

Examples are shown below:
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Application Examples:

— Used to quantify synapses in T cell APC (antigen presenting cell) con-
jugates.

Morphology Mask
TheMorphology mask includes all pixels within the outermost image contour. This
mask, which is used in fluorescence images, is best used for calculating the values
of overall shape-based features.

Object Mask
TheObject mask segments images to closely identify the area corresponding to the
cell. It is based on the assumption that background pixels exhibit high uniformity to
each other. This helps distinguish the background from the cell pixels. Themask
characterizes the background pixels using a set of features and then segments the
image by determining all the pixels that deviate from the background feature set. The
default option is used for the default segmentationmasks. The tight option uses a dif-
ferent set of features to characterize the background which results in a tighter fit
around the cell.

Examples are shown below:

Image
Object
(default)

Object
(tight)
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Application Examples:

— Used to get a close fit around the cellular area (tight option).
— Can be used in lieu of themorphmask for applications where themorph is

so tight that it provides incompletemasking, sometimes splitting cells into
two regions, such as a nuclear dye image of cells in anaphase or telo-
phase.

— Can be used in lieu of themorphology mask with the Similarity feature
whenmeasuring nuclear translocation for better separation between
untranslocated and translocated cells (tight option).

— Used as the default segmentationmasks (default option).

Peak Mask
The Peak mask identifies intensity areas from an image that have local maxima
(bright) or minima (dark). Initially, the peak mask will identify all peaks in the image.
To select peaks which have certain brightness, the spot to cell background ratio is
used. This is the ratio between the spot pixel value to themean camera background
value in the original image.

Below is an example of the Peak, bright option.

Application Examples:

— Used with the Spot Count feature to quantify the speckleness of cells.
— Separate connected spots in a Spot Mask into individual components.
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Range Mask
The Rangemask provides a capability to select components in an image within a
selected size and/or aspect ratio by setting aminimum andmaximum area andmini-
mum andmaximum aspect ratio.

To select pixels within a range of intensity values, see “Intensity Mask”.

Application Examples:

— Use with a Spot Mask to constrain the Spot Count feature to round spots.
— Use on any other mask that has multiple components to define unwanted

objects such as debris, objects that are too small or whose shapes are not
circular.

Skeleton Mask
The skeletonmask provides the barebone structure of the object from the starting
mask. Two options are available: thin or thick skeletons. The thin option produces
the condensed shape of the object and typically takes a form of 1-pixel wide skeletal
line. The thick option is intensity weighted. The thin option is dependent on the
shape of startingmask; thick uses the pixel intensities and is less sensitive to the
shape of the startingmask. The user will need to pay careful attention to the starting
mask. In the example below theMorphology mask of the image was used as the
startingmask for creating the skeleton.
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Application Examples:

— Thick skeletons can be used with shape-based features such as sym-
metry to accentuate the shape of an object, and provide greater sep-
arations.

— Separate singlets and doublets by computing the area of the thin skeleton
mask. We have used the object(tight) for this case.

— Nuclear morphology measurements with lobe count feature for cell clas-
sification cells.

Spot Mask
The Spot Mask has two options: bright or dark. The bright option obtains bright
regions from an image regardless of the intensity differences from one spot to
another. The ability to extract bright objects is achieved using the an image proc-
essing step that erodes the image and leaves only the bright areas. The dark option
obtains dark regions. The spot to cell background ratio and radius are specified by
the user. The spot to cell background ratio is the spot pixel value divided by the back-
ground in the bright detail image. A radius value of x implies that the image contains
spots with thickness of 2x+1 pixels.

The figure below illustrates the open residue process. The bright areas are eroded
from the original image and the detail eroded image is subtracted from the original
image resulting in the bright detail image.
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The image pairs below show objects in grayscale next to their corresponding Spot
Masks in cyan. Spot masks can be further refined using the Peak and/or Range
masks. See “Peak Mask”“RangeMask”.

Application Examples:

— Used with the Spot Count feature to enumerate spots in images such as
for FISHIS®.

— Used with Intensity features to quantify intensity in spots.
— Dark spot finds valleys in images such as the low intensity between 2

stained nuclei and is useful for finding immune synapses.
— Identifies the dark areas in red blood cells or parasitic infections in bright-

field imagery.

System Mask
The Systemmask segments objects in an image based on a probability model of
how pixels should be grouped together. The user sets a weight value that defines a
loose or tight grouping. A low weight value groups in amore permissivemanner.
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Shown is an example of a cell with a apoptotic bleb that is not masked with the Sys-
temmask weight set at 5 but is masked with the Systemmask weight set at 2.

Application Example:

— Used on brightfield images to capture a low contrast areas such as cells
that undergo a blebbing process, tails of sperm or other low contrast type
of structures.

Threshold Mask
The Thresholdmask is used to exclude pixels, based on a percentage of the range of
intensity values as defined by the startingmask. The user chooses the starting
mask when creating the Thresholdmask. See also “Intensity Mask”.

In the example below, cell #10678 is bright and cell #11992 is dim. The 50% Thresh-
old mask is similar for both images whereas the Intensity mask 250+ is quite dif-
ferent, since only a few pixels in the dim image are greater than 250 counts, while
most of themetaphase plates in the bright image aremasked.

Application Example:

— Used with the Area feature to define apoptotic cells.
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Valley Mask
The Valley mask is a rectangular mask that sits between two bright regions in a start-
ingmask, such as between two nuclei. It is constructed by finding theminimum
intensity along the skeletal line between these two bright regions. The skeletal line is
obtained internally using the skeleton (thin) masking as described in “Skeleton
Mask”. This minimum intensity identifies the intersection between the two objects.
Themask is drawn perpendicular to this skeletal like. The length of the valley mask
rectangle is equal to theminor axis of the object and the width of themask is defined
by the user in pixels.

Application example:

— Quantify the intensity of a probe in an immune synapse.
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Troubleshooting

Troubleshooting
This chapter covers common issues and provides solutions.

Application Hanging
If the IDEAS application is hanging, theremay be amemory issues, especially with
large file processing. Youmust use the Task Manager to force quit the application.

1 Press and hold Ctrl + Alt + Delete.
2 TheWindow Task Manager appears.
3 Under the Applications tab, select IDEAS Application.
4 If the status is Not Responding, select End Task.
5 Themanager will force quit the application after a confirmation.

Compensation
Sometimes an appliedmatrix produces poorly compensated data. This can happen
for a number of reasons: 1) miscalculation of the compensationmatrix by inclusion
of inappropriate events (such as doublets, saturated pixel events, or artifacts), 2)
controls used for matrix calculation differ significantly from the experimental sam-
ples (different cell type, different probe), or 3) cells exhibit substantial auto-
fluorescence. This protocol describes amethod for manually adjusting and validating
a compensationmatrix for difficult samples.

To troubleshoot and repair a compensationmatrix:

1 Create a population of cells that aremiscompensated using the tagging tool. See
“Creating Tagged Populations”. Choose single cells that are exhibiting crosstalk.
Choose a range of intensities from negative to bright but not saturated, preferably
single color. If single color cells are not available, choose cells with a distinct
staining pattern in the peak channel.

2 Create Intensity scatter plots of adjacent channels in order to observe the over-
or under-compensation.

3 Identify thematrix values that need adjusting by inspecting the scatter plots and
images. Each column contains the coefficients for the peak channel into the cor-
responding crosstalk channels (rows). For example the crosstalk of channel 2
(green) into channel 3 is highlighted in thematrix below.
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• Undercompensation (crosstalk coefficient is too low):
Plots: Intensity mean for the single color positive population is higher than the
unlabeled population in the crosstalk channel or the intensity in the crosstalk
channel trends diagonally upwards.
Images: the crosstalk channel contains an apparent fluorescent mirror-image.

• Overcompensation (crosstalk coefficient is too high):
Plots: Intensity mean for the single color positive population is lower than the
unlabeled population in the crosstalk channel or the intensity in the crosstalk
channel trends diagonally downwards.
Images: the crosstalk channel contains dark spots corresponding to the bright
spots in the fluorescent channel of interest.

4 In the Compensationmenu choose View/Edit Matrix andmanually change the
incorrect crosstalk matrix values identified above. Start with changes of ~.1 or
~.05 and use smaller and smaller increments as you refine thematrix.

5 Click Preview and choose the tagged population to view the results of the
changed coefficient.

6 Repeat steps 4 and 5 until thematrix is corrected.
7 Click Save, appendmanual to thematrix name, then click OK.
8 Open the .cif file and use the new matrix to create a new .daf file.

Creating a TIFF
If you cannot see the TIFF image that you created, trying changing the resolution to
8-bit.
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Deleting a Population and Region
Often, a user deletes a population but forgets to delete the region. Deleting a pop-
ulation does not delete the region. Youmust delete the region itself.

Object Number set to Zero
When opening a .daf file, theremay be an error if the object number is set to zero.
This can happen if the data was collected during a crash within INSPIRE. This error
can be corrected with the following procedure.

1 Select Tools > Merge .rif Files.
2 Click Add Files to select the single .rif file.
3 Click OK. Enter a new name if desired. The single .rif file will merge with itself

and rewrite the file with the proper object count.

Buttons or options in windows are not appearing
When the font size setting is set to large somewindows will not size properly caus-
ing buttons or text boxes to not appear. To change the font size inWindows go to the
Control Panel>Display>Appearance and select Font size Normal.
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Glossary

Term Definition

acquisition
The process of collecting data from the ImageStream cell analysis
system.

brightfield
A type of illumination that uses transmitted light. On the ImageS-
tream cell analysis system, this light is provided by a halogen lamp.

brightfield image
An image that is produced by transmitted light. On the ImageStream
cell analysis system, this light is provided by a halogen lamp.

brightfield The camera channel that the brightfield image appears in.

calibration
The precise adjustment of instrument components based on test
results for the purpose of optimizing functionality.

CCD See charge-coupled detector (CCD).
One of the six physical partitions on the camera. Each camera chan-
nel collects a different spectral band of imagery, which allows for the
collection of brightfield, darkfield, and up to four fluorescence images
per object.

charge-coupled detec-
tor (CCD)

A sensor for recording images that consists of a particular type of inte-
grated circuit—one that contains an array of linked, or coupled, capac-
itors. Under the control of an external circuit, each capacitor can
transfer its electric charge to either of its neighbors.

coefficient of variation
(CV)

Themean-normalized standard deviation, expressed as a per-
centage. The CV measures the variation of a feature value inde-
pendent of the populationmean value. The formula is: CV = 100 ×
standard deviation / mean

CV See coefficient of variation (CV).

compensation

The process of removing intensity—specifically, intensity that was
derived from fluorescence crosstalk that originated from dyes cen-
tered in other channels. The IDEAS application performs com-
pensation on a pixel-by-pixel basis.

compensation matrix
The set of values that report the relative amount of fluorescence of
each probe in each channel. The compensationmatrix is used to sub-
tract intensity originating from dyes centered in other channels.

crosstalk
Leakage of fluorescence signal from a fluorochrome into adjacent
channels.

darkfield

A type of illumination in which the sample is illuminated at angles that
do not directly enter the objective. On the ImageStream cell analysis
system, 90-degree angle side scatter from the 488-nm laser provides
the darkfield imagery.

FISH See fluorescent in situ hybridization (FISH).

fluorochrome
A fluorescent dye used to label cellular constituents or specific
probes of cellular constituents.

fluorescence Light emitted by a fluorescent dye following excitation.
fluorescence com- The adjustments made to remove the fluorescence emissions of a

Table 1: Glossary of Terms
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Term Definition
pensation fluorochrome into adjacent channels.

fluorescent in situ hybrid-
ization (FISH)

A physical mapping approach that uses fluorescent tags to detect the
hybridization of probes with metaphase chromosomes or the less-con-
densed somatic interphase chromatin.

gain The amplification of a detector signal.

grayscale
The brightness level, ranging from black to white, of a pixel or group
of pixels.

pixel
A pixel is equal to a half micron in length with the 40X objective, 1
micron with the 20X objective and 0.33microns with the 60X objec-
tive. Note that 1 pixel = x µm2.

saturation
The state of a pixel that has a value at or above 1023 for the IS100 or
4095 for the ImageStreamX.

segmentation The process of discriminating an object from its background.

spectral decomposition
element

A custom set of longpass dichroic filters arranged in an angular array.
The spectral decomposition element directs different spectral bands
to laterally distinct channels on the detector. With this technique, an
image is optically decomposed into a set of six sub-images, each cor-
responding to a different color component and spatially isolated from
the remaining sub-images.

spatial offset
The registration error of the six channel images for a single cell. The
spatial offset is measured during calibration and the values are saved
to the image database.

Table of Coefficients
The table used by the compensationmatrix to place the detected light
that is displayed in each image into the proper channels, on a pixel-
by-pixel basis.

template

A file that saves the set of instructions for an analysis session. Note
that a template contains no data; it simply contains the structure for
the analysis. This structure includes definitions of features, graphs,
regions, and populations; image viewing settings; channel names;
and statistics settings.
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Index

A

Acquisition information 47

Advanced Analysis 34

Analysis Area

adding an image panel 72

adding text 78

overview 61

printing 104, 113

tools 62

UI 7

Apoptosis

wizard 18

Application defaults 4

Area 127

ast

about 9

B

Batch processing 47

Brightfield information 47

Building Blocks 32

Fluorescence Positives-one color 32

Fluorescence Positives-two color 32

Focus 32

Single Cell 32
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Single Cell Default 32

Size/SSC 32

Tool 63

C

Camera settings information 47

Cell Classifiers 47

Cell Cycle

using a wizard 20

Channels collected 47

cif

merging 44

opening 37

saving 41

cif;about 8

Co-localization

using a wizard 22

Color

Show in Image Gallery 54

Compare, FlowSight, FlowSight QI, ImageStream 2

Compensation

definition 3

editing the matrix 43

overview 41

view matrix 47

Compensation matrix file

about 9
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Composites 59

Copying images 61

Corrections information 47

ctm

about 9

D

daf

about 8

opening 39

saving 40

Data analysis steps 12

Data analysis tools

about 51

Data files

ast 9-10

cif 8, 10

ctm 9-10

daf 8, 10

new from populations 45

opening 34

rif 8, 10

type 10

Defaults

application 4

compensation matrix 2

directories 4
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mask 2

mask color 5

population color 5

population symbol 5

statistics for a graph 5

Diameter 127

Directories

changing default 4

Display

making composites 56

setting properties 56

setting properties using a wizard 16

views in the Image Gallery 56

E

EDF

kernels 47

Example data files 4

Exporting data 111

features 111

pixel intensity values 112

F

Feature Manager

overview 86

tasks 91

tools 87
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Features

angle 134

angle intensity 134

Area 127

aspect ratio 142

aspect ratio intensity 143

Bkdg mean 158

Bkgd std dev 158

bright detail intensity 150

camera line number 172

camera timer 173

categories 118

centroid delta x and y 136

centroid delta xy 137

centroid x and y 135

circularity 144

compactness 145

contrast 151

create combined 90

create multiple 89

create new 88-89

delete 91

diameter 127

elongatedness 146

find a feature 92

flow speed 173

gradient max 152
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gradient RMS 153

height 128, 133

intensity 158

internalization 170

lobe count 147

major and minor axis intensity 130

major axis and minor axis 130

max contour position 139

min pixel 162

modulation 155

object number 173

object per mL 173

object per sec 173

overview 116

perimeter 131

raw intensity 163

raw max pixel 163

raw mean pixel 164

raw median pixel 165

raw min pixel 165

saturation count 166

saturation percent 166

shape ratio 148

similarity 171

similarity texture R3 168

size 126

spot area min 132
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spot count 156

spot distance min 140

spot intensity min 167

std dev 156

symmetry 2 149

table alphabetical list 119

table by category 122

thickness max 132

time 173

valley x and y 141

viewing 87

width and height 128, 133

without QI 126

File name extensions 4

Focus building block 32

G

graphs

copy and paste 70

Graphs

apply or remove region 71

creating 63

creating regions 68

legend 67

moving 67

printing 115

resizing regions 69
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statistics 66

zoom 70

Guided Analysis 12

H

Hardware requirements 3

Histogram tool 62

I

IDEAS

getting started 12

interface 7

Image

copy 61

individual image 60

Image Display intensity mapping 57

Image Gallery

channel view 54

composites 59

overview 53

population 54

printing 104, 113

properties 55-56

properties tool 54

resize 55

show-hide color 55

show-hide masks 54

tools 54
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UI 7

using 53

views 58

Image panel size

change in Image Gallery 56

Individual image

display properties 74

manipulating 60

measurement tool 73

pixel intensities 72

show-hide mask 76

Internalization

using a wizard 24

L

Laser information 47

Line Region Tool 63

M

Mask Manager

tools 83

Masks

about 174

combining 83

creating new 80

dilate 175

edit 84

erode 175
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examples 84

fill 176

intensity 176

list of 81

morphology 178

object 178

peak 179

range 180

show in Image Gallery 54

skeleton 180

spot 181

system 182

threshold 183

valley 184

viewing definitions 83

Merging cif files 44

Merging raw images files 44

Mitosis

using a wizard 20

N

Name and Color

Image Gallery 56

Nuclear Localization

using a wizard 26

Nuclear translocation

using a wizard 26
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O

Object Data 76

Object Feature Values Table 63

One color histogram building block 32

Opening files

using a wizard 15

Oval Region Tool 63

P

Pointer tool 62

Polygon Region Tool 63

Population Manager 97

tools 99

Population Statistics 79

Population Statistics table 63

Populations

creating 100

creating a new data file from 45

creating combined 98

deleting 98

display properties 98

during acquisition 47

viewing 98

Printing 104

R

Rectangle Region Tool 63
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Region Manager 101

Regions

editing 102

viewing 101

Reporting 102

changing color mapping 104

graphs and statistics 105

Images 104

Images and Graphs 103

light mode graphs 103

statistics 107

statistics from multiple files 110

Reports

printing data 104, 113

rif

about 8

merge 44

opening 35

S

Sample Information

view 46

Saturation

view in Image Gallery 54

Saving data files 40

ast 41

cif 41
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daf 40

Template 41

Scatter plot tool 62

Scatter plots

show-hide populations 71

Screen resolution 4

Select All Panels Tool 63

Shape Change

using a wizard 28

Single Cell Building Block 32

default 32

Size/SSC Building Block

default 32

Software requirements 3

Spot Count

using a wizard 30

T

Tagging tool 54, 62

Template file

about 9

default 2

definition 3

saving 41

Text tool 63

TIFs

creating 112
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Two color scatter plot building block 32

V

Views

custom 58

Volume information 47

W

Wizards

Apoptosis 18

Begin Analysis 17

Cell Cycle - Mitosis 20

Co-localization 22

Display Propertes 16

Internalization 24

list 14

Nuclear Localization 26

Open File 15

Shape Change 28

Spot Count 30

Tool 63

Workflow; data analysis workflow 3

Z

Zoom

Image Gallery 54
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